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Release Notes

Welcome to the June 2022 release of IBM TRIRIGA Application Suite 11.1, including IBM® TRIRIGA® 11.1,
IBM TRIRIGA Application Platform 4.1, IBM TRIRIGA CAD Integrator/Publisher 13.1, and IBM TRIRIGA
Connector for BIM 4.1.

For the installer-based version of TRIRIGA, this release includes the following two installation options:

e Anew installation of IBM TRIRIGA Application Platform 4.1 and IBM TRIRIGA Applications 11.1.
e AnIBM TRIRIGA Application Platform-only upgrade installation from 3.0.x or higher to IBM TRIRIGA
Application Platform 4.1.

The IBM TRIRIGA Applications can be incrementally upgraded to 11.1 Applications after the platform
upgrade is completed. For more information about specific scenarios, view the Upgrading information on IBM
Documentation for IBM TRIRIGA Application Platform 4.1.

Note — The older IBM TRIRIGA wiki information, formerly located on developerWorks, is
@ migrated to the IBM Docs for IBM TRIRIGA Application Platform 3.8. As this wiki content is

gradually converted and merged into ongoing releases of the 4.x platform and 11.x application
content, you can access this link to 3.8.

For more information, see the IBM TRIRIGA Release Information page on IBM Support.

These release notes include the following:
e Anoverview of enhancements and changes
e Alist of known limitations
o Alist of documentation changes

e Many of the descriptions include an internal reference number (Tri-nnnnnn, IJnnnnn, IVnnnnn,
and/or RFE-nnnnnn)

In addition to this document, this release includes the following files, available from the Release Notes page
on IBM Support:

e The enhancements, important information, known limitations, changes, and property file changes for
this release are included in spreadsheet form in an XLS file. You can use the column filters to view
only the information you need.

e Aseparate version of the release notes that is specific to Lease Accounting includes documentation
of Lease-related new functions. This document also compiles the release notes related to Lease
Accounting from version 10.5.3 to the present.

Warning - CUSTOMERS SHOULD CONSULT WITH THEIR ACCOUNTING ADVISORS AND

IMPLEMENTATION PARTNERS TO DETERMINE WHAT IMPACT, IF ANY, MAY RESULT

x FROM THE CHANGES IN THIS RELEASE/FIX PACK/OM PACKAGE. THIS RELEASE/FIX
PACK/OM PACKAGE MAY CONTAIN CHANGES TO CERTAIN CALCULATION MODELS

WHICH MAY AFFECT PREVIOUSLY PUBLISHED FINANCIAL RECORDS AND HOW FUTURE

RECORDS ARE CALCULATED.
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What’s New in This Release

With IBM TRIRIGA Application Suite 11.1, including IBM TRIRIGA 11.1, IBM TRIRIGA Application Platform
4.1, IBM TRIRIGA CAD Integrator/Publisher 13.1, and IBM TRIRIGA Connector for BIM 4.1, IBM TRIRIGA
continues to add valuable functionality, fix defects, and reduce the effort necessary for new and existing
customers to implement our products.

IBM TRIRIGA Application Suite (TAS) 11.1 is an integrated workplace management system that enables
access to a full set of real estate and facilities applications, with flexibility to start with any real estate or
facilities discipline and expand into other areas. This release offers:

o Simplified, suite-based licensing structure that provides a single point of access to the full suite of
real estate and facilities management capabilities.

e IBM TRIRIGA Application Suite Managed Service for a single point of access to the full range of IBM
TRIRIGA Application Suite real estate and facilities management capabilities running on IBM Cloud®
with the support of IBM operational experts.

For additional information on the TRIRIGA Application Suite, see IBM Documentation.

IBM TRIRIGA 11.1 delivers:

Disclosure Reports
Historical Reporting and Foreign Currency Exchange Rate (FX) Handling

e  When reporting historical financial information, TRIRIGA now reports financial information from prior
periods when the reports are run after the original run date. As a result, TRIRIGA identifies and
provides the version of a historic lease record to use for Disclosure Reporting. In addition, the FX
handling capabilities of TRIRIGA have been significantly enhanced to enable reporting in both
functional and reporting currencies.

e New BIRT disclosure reports have been developed to ensure that the reported financial information
from previously reported periods do not change when the report for that period is run subsequently.
The journal entry process now runs in both the lease currency and the functional currency using a
new currency conversion feature. In addition to converting the Journal Entries at established FX
rates, calculation logic accounts for FX gain/loss on the Lease Liability and the Accrued Interest
Balance due to changes in the month end FX rates.

e Functional Accounts have been added to collect and summarize the journal entries into Lease
Summary Balances (LSBs). A snapshot of the LSB for each Functional Account is created when the
journal entries are processed, and the period closed. This snapshot record feeds the Disclosure
Reports and the newly created Roll Forward Reports. A separate set of LSBs is created and stored for
local reporting. When a historic disclosure is required to be run, it sources data from the appropriate
LSBs.

Remeasurement of Leases denominated in currencies other than the Functional Currency

e Thejournal entry process will now run in both the lease currency and the functional currency using
the foreign exchange (FX) rates set up in the Currency Conversions area under Tools-Utilities in
TRIRIGA.

e The Functional Currency is set at the Organizational/Business Unit level in TRITIGA by accessing My
Company under Portfolio-Organization. Consult the 11.1 Lease and Owned Property Contract
Management User Guide.

e Inaddition to converting the Journal Entries at established FX rates, TRIRIGA now accounts for FX
Gain & Losses on the Lease Liability and the Accrued Interest Balance due to changes in the month
end FX rates.

e The Journal Entry Templates and TRIRIGA reports have been updated in accordance with ASC 842-
20-55-10 Leases Denominated in a Foreign Currency.
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Roll-Forward Reports

The financial information for the changes and movements in Lease Liabilities and Right-of-Use-Asset values
for each reporting period required to reconcile opening and period end balances and provide audit trail and
transactional support is now available in newly created Roll Forward Reports. These reports are available in
both functional and reporting currencies.

New Right-of-Use Asset Roll Forward and Lease Liability Reports have been delivered. The new reports
provide summary and detail schedules of the period opening and closing balances with all the movements
that occurred during the period. The reports consist of breakouts of the Gross Asset Value and the
Accumulated Amortization accounts for the Right-of-Use-Asset and for the Liability and the Accrued Interest
accounts for the Lease Liability. The reports support confirmation that everything is being recorded and
accounted for correctly.

o Theinputs to the reports are pulled from the Functional Accounts Lease Summary Balances
and are available in both the functional and the reporting currency.

o Period ending balances for each component are reconciled and checked against the
balances displayed on the accounting schedules in both the accounting and the local
reporting tabs.

o Reconciliation in the functional currency will include FX gains and losses associated with the
lease liability. TRIRIGA calculates these values in accordance with the US and international
accounting standards.

o Thereconciliation in the reporting currency includes Cumulative Translation Adjustments
associated with Balance Sheet and Lease Expense accounts resulting from movements in
month end rates and average rates.

The Right-of-Use Roll Forward is separated into three sections as follows: Gross Asset Value, Accumulated
Amortization and Net asset Value. In addition to support IFRS requirements there is a section for the
Accumulated Impairment Reserve. The Lease Liability report is similarly separated into three sections as
follows: Lease Liability, Accrued Interest Balance and Total Lease Liability.

Both Roll Forward Reports reconcile the period end carrying amounts in the Functional and Reporting
currencies with the Accounting Schedules at the individual lease level.

e The Lease Liability Roll Forward reconciliations in the Functional Currency separately account for
each of the FX Gains/Losses associated with the Lease Liability and with the Accrued Interest
Balance.

e Both the Lease Liability and the Right of Use Asset Roll Forward Reports separately account for and
reconcile each the CTA elements associated the Balance Sheet accounts and the P&L Lease Expense,
Impairment, Gain/Loss and FX Gain & Loss on the Lease Liability.

An additional Non-Cash Supplemental report replaces the Lease Initial Recording Report, using data from the
Lease Summary Reports.

GASB 87 Lessee Accounting

New functionality supports the key provisions, accounting treatment, and disclosure reporting requirements
of GASB Statement 87 for leases for state or local government organizations in the US. The new functionality
covers Terminology, Lease Classification, Determining and Reassessing Lease Term, Transitioning existing
Capital and Operating Leases, Initial Recognition and Subsequent Accounting, Remeasurements and
Reassessments, Impairments, Index Adjustments, Terminations and Expirations, and Disclosure Reporting.

In a governmental lessee, the lease accountant can apply the required accounting treatment in TRIRIGA:

e At the commencement of the lease term, the lessee recognizes a lease liability and an intangible
right-to-use lease asset (lease asset). The lease liability will be measured at the present value of
payments expected to be made during the lease term.

e Lease payments will result in reduction of the lease liability and recognition of interest expense.

© Copyright IBM Corporation 2022. 5



The lease asset will be measured as the sum of the initial measurement of the lease liability, initial
direct costs, and lease payments made prior to commencement, less any lease incentives.

The lease asset will be amortized over the shorter of the lease terms or the useful life of the
underlying asset.

As regards transition to GASB 87, the statement requires that leases are recognized and measured
using the facts and circumstances that existed at the beginning of the period of implementation. If
applied to earlier periods, leases are recognized and measured using the facts and circumstances
that existed at the beginning of the earliest period restated.

The cumulative effect, if any, of applying this statement are reported as a restatement of beginning
net position (or fund balance or fund net position, as applicable) for the earliest period restated.

Drawing Manger

A new application to manage all CAD drawings stored in TRIRIGA. You can search, view, and delete the
drawings. Apart from this, you can download the associated .dxf file

IBM TRIRIGA Application Platform 4.1 brings:

A new Microsoft Exchange webhook integration option for clients using the Microsoft Graph API
allows for custom integrations to be built between TRIRIGA and Microsoft Exchange that enable
TRIRIGA to receive notifications when changes are made to Microsoft 365 resources, such as
meeting rooms, managed through the Graph APIL. A new form allows for creating and managing
subscriptions, and a new workflow event type enables receiving and processing notifications.

New REST API endpoints for queries and reports that enable easier development of integrations for
TRIRIGA.

Other minor enhancements and fixes.

IBM TRIRIGA CAD Integrator/Publisher 13.1 features:

Minor enhancements and fixes

IBM TRIRIGA 11.1 Enhancements

The following specific enhancements to IBM TRIRIGA are in this release in addition to the enhancements
described above:

Area of Impact Description

Capital Project A new field called Responsible Role has been added to the Task record under the

Facilities Projects

General tab > Responsible Person section > Responsible Role. This field on Task
record can be selected manually while creating the record.

On click of the Assign Task by Role section action in Capital/Facilities Project
record > Schedule Tab > Project Tasks section, the system will pick the
responsible role from the General tab of the selected Task record and find
corresponding responsible person from the matching contact role of
Capital/Facilities Project. The retrieved responsible person details would be
mapped on the general tab of Task record > Responsible Person section.

Example: We have a Facilities Project and Building Condition Manager contact
role for which Person A is assigned as contact.

Now we create a work task record from Facilities Project > Schedule tab > Project
Tasks section. On this Work Task record, on the General tab, there is a section
called Responsible person where we have selected Building Condition Manager
as the responsible role.

© Copyright IBM Corporation 2022. 6



Area of Impact Description

Next, on click of section action "Assign Task by Role" in Facilities Project record >
Schedule Tab > Project Tasks section, the Person A would be mapped on the
General tab of Task record > Responsible Person. (Tri-67375-1J26402)

Graphics There is now an application to manage all CAD drawings stored in TRIRIGA. You

Space Assessment can sgarch, view, and c!elete the drawings. Apart from this, you can download the
associated .dxf file. (Tri-78986)

Lease - Asset and Real An Abandonment Reversal option is now available. An accountant can perform an

Estate Abandonment Reversal on a lease by doing an Accounting Revise > Contractual
Factors. Uncheck the Abandonment checkbox and the Decommission Date on
the Schedule Summary section will be cleared. The lease will continue to be re-
calculated like a Finance lease, the asset will now be amortized straight lining up
to the lease term. (Tri-75519)

Lease - Asset and Real = Lease process workflows are now enhanced to improve the performance of
Estate generating accounting schedules for a lease. (Tri-72172)

Lease - Asset and Real = The Gain/Loss column in Accounting Schedules follows the same sign convention

Estate in all the scenarios. If it’s a loss, it shows a positive (+) amount in the gain/loss
column. If it’s a gain, it shows a negative (-) amount on the gain/loss column.
(Tri-67641-1332130)

Lease - Asset and Real = The Total Rent Expenses fields in the Schedule Summary section (Accounting
Estate tab) and Amortization Summary section (Local Reporting tab) now include the
Dismantle Cost for an IFRS lease. (Tri-77302)

Lease - Asset and Real A new period, Original Accounting Start Period, is added to the list of Calculation
Estate Periods as a Journal Entry Calculation input. (Tri-65694)

Lease - Asset and Real | A new column, Nth Period From Cumulative From Period, is added in the Lease
Estate Journal Entry Setup form, on the Calculation Inputs tab. This helps in selecting
Nth Period from the Cumulative From period in the calculations. (Tri-65695)

Lease - Asset and Real Prepayment Amount added during lease amendment will now be treated in the
Estate same manner as prepayment amount would be accounted for in connection with
a new lease. (Tri-67394)

Lease - Asset and Real | Lease Local Reporting Utility is designed for the leases where local reporting is

Estate not enabled upon the initial lease activation, however, at a later point, there is a
need for local reporting schedules. The utility will create a mirror lease, a replica
of the original lease. Based on the local reporting look back period set on the
application settings record, the system may perform local reporting standard
adoption on the mirror lease. Next, all the modifications performed on the
original lease of types Amendment, Change In Assessment, and Contractual
Factors will be applied to the mirror lease in the same sequence. Finally, after all
the modifications are updated to the mirror leases and lease schedules
recalculated, all the details from the lease local reporting tab of the mirror lease
will copy over to the original lease. For more details, refer to the Lease Local

© Copyright IBM Corporation 2022. 7



Area of Impact Description

Reporting Utility user guide in version 11.1.
(Tri-62980-1J22846)

Lease - Asset and Real An Abandonment option is now available. An accountant can perform an

Estate Abandonment on a lease by doing an Accounting Revise > Contractual Factors.
The Abandonment checkbox will be available, and the Abandonment Date
(Decommission Date) must be entered to accelerated amortized the asset to the
Abandonment Date.

The Decommission Date on the Schedule Summary section will be populated
with the Abandonment Date. Also, the Remaining Useful Life field will be
calculated from the Modification Effective Date to the Decommission Date.

The lease will be re-calculated like a Finance lease, the asset will be amortized
straight lining up to the Decommission period, for an Operating lease, the Rent
Expense is NO longer straight line. The lease will continue to be calculated like a
Finance lease for any subsequence modifications. (Tri-70715-13J31113)

Navigation Starting with TRIRIGA 11.0, the Timeout User Group Manager can be accessed
through the TRIRIGA Global Menu at the following location: Tools > System
Setup > General. (Tri-73513)

Reservations On the Food Service page, the Order Name field is now mandatory for Location
Reservation & Concierge Reservation. (Tri-66242-1J25484)

UX Workplace Services = When using the Room Reservation application on Safari on iPhone with Voice

App Over enabled, the screen reader reads from the middle of the page (usually the
details of a reservation). The screen reader now focuses on the top of the page
(the home button). (Tri-77768-1336458)

UX Workplace Services On an iPhone with the Voice Over feature enabled, after swiping right from the My

App Reservations button, the focus will move to the next item and announce the
dimmed button (disabled navigate to the previous page of reservations button)
instead of the New Reservation button. (Tri-77769-1J36460)

UX Workplace Services = IniOS, when the voice over is turned on, if you open the search location page

App while creating a new reservation, the fields on the previous page are not
announced. Instead, the voice over loops to the back button, which is in the
upper left of the page. (Tri-77794-1J36466)

© Copyright IBM Corporation 2022. 8



IBM TRIRIGA Application Platform 4.1 Enhancements

The following enhancements to the IBM TRIRIGA Application Platform are in this release in addition to the
enhancements described above:

Area of Impact Description

Administrator Console

Connector for
Business Applications

Graphics

Licensing

Navigation

Reservations

Reservations

Reservations

Security

TRIRIGA application developers can now access Query Data documentation, which
can be used for integrations. You can access the documentation at
<TRIRIGA_URL>/api/doc. (Tri-62331)

The Connector for Business Applications (CBA) operations
putCurrencyConversionRates and getCurrencyConversionRates have been updated
to handle a new property called frequencyGroup. If a frequencyGroup value is not
specified, it will default to "Daily". This property is only applicable for Application
11.1 and above. (Tri-71198)

The TRIRIGA Platform now has REST APIs for querying, uploading, and deleting
CAD drawings stored in TRIRIGA. Access to the new APIs is provided through the
tririga-react-components npm package. (Tri-78734)

New TAS-Limited-Occasional AppPoint consumption license tier added for the
TRIRIGA Application Suite. (Tri-79399)

Navigation items of target type Application with the open in new window checkbox
deselected will now appear as selectable items in the Home Page list and the
Project Home Page list on the user's My Profile page. Note that if a portal and an
Application navigation item have the same name, only the portal will appear in the
above mentioned lists. A warning will be displayed in server.log if this scenario is
encountered. (Tri-72848)

The Location Reservation room search now filters the search result set so that
rooms that are not available due to reservation policies are not shown in this result
set. (Tri-68246)

The following new custom tasks are now created for the Exchange integration:
List all the calendar events in a date/time range for a mailbox.

Query details of a calendar event including organizer and attendees.

When The Microsoft Graph API is enabled for Exchange integration, support is now
available for notification of changes to Exchange calendars by subscribing to web-
based event notifications from Exchange to TRIRIGA. (Tri-78872)

The system user is now required to change the default password on first login.
After new installation or upgrade, if system users log in to TRIRIGA with the legacy
default password, they will be redirected to a screen that will require a password
change. This change also impacts integrations, such as CAD, tri-deploy, CBA, etc.
System users will no longer be able to do integrations by using the legacy default
password. (Tri-79131)
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Area of Impact Description

Security Resolved a security issue caused by improper scoping of a static variable.
(Tri-76077)

Security Resolved a reported security scan issue caused by improper scoping of a static

variable. (Tri-76074)

IBM TRIRIGA CAD Integrator/Publisher 13.1
Enhancements

The following enhancement to the IBM TRIRIGA CAD Integrator/Publisher is in this release in addition to the
enhancements described above:

Area of Impact Description

CAD Integrator Batch Edit now honors the Security groups of logged-in users. CAD Integrator
Batch Edit now respects per user form tab and section access restrictions.
(Tri-70797)

IBM TRIRIGA Connector for BIM 4.1 Enhancements

The following enhancement to the IBM TRIRIGA Connector for BIM is in this release:

Area of Impact Description

Connector for BIM Publish Floor Plan now deletes temporary files created during the publish process
and has an option to also delete the .dxf file after publishing is complete.
(Tri-61784)

Connector for BIM IBM TRIRIGA Connector for BIM is now compatible with Revit 2023. (Tri-80949)
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Important Installation and Upgrade Information

Pre-10.3.0 requires modification scripts

If you are upgrading from a pre-10.3.0 version of the application and have not previously done so, apply the
SQL script to update the system fields with sub-attribute type of CreatedDateTime to CreatedDateTime
(Number) and ModifiedDateTime to ModifiedDateTime (Number). Scripts for Oracle and Microsoft SQL Server
are located on the upgrade disk in the \Scripts folder. Instructions are within the scripts.

You can apply the script regardless of the platform version, but you MUST apply the script before upgrading
the Application.

For Oracle, run SetVarcharColsToNumeric_ORCL.sql.

There are two scripts for MSSQL, SetVarcharColsToNumeric_MSSS.sql and
SetVarcharColsToNumeric_MSSS_Publish_BO.sql. Run SetVarcharColsToNumeric_MSSS.sql first. When it
completes, run SetVarcharColsToNumeric_MSSS_Publish_BO.sql.

Do not delete OM packages for pre-10.5.0 application upgrades

If you imported pre-10.5.0 application upgrade packages into an environment on platform version 3.5.0 or
3.5.0.1, please do not delete the packages from the Object Migration tool. Additionally, do not delete the
notifications related to the import of these packages.

Object Label cleanup will run the first time the AppServer is started on platform version 3.5.2 and higher to
ensure that the Root object label is applied appropriately to modules, business objects, forms, queries, and
workflows. Packages and notifications are used for tracking purposes to clean object labels for modules,
business objects, forms, queries, and workflows that are incorrectly given the In Progress or
ObjectLabelInProgress object label when you did not modify them.

If notifications related to the imports have been deleted, the object label cleanup will still run, but any in
progress labels given to an object by a manual modification will be changed to the Root object label, if the
manual change happened on the same day as the pre-10.5.0 application upgrade on platform version 3.5.0 or
3.5.0.1, and by the same user who applied the upgrade.

If application upgrade packages have been deleted from the Object Migration tool, the object label cleanup
will not be able to ensure that the Root object label is applied appropriately to objects imported by those
deleted packages.

Pre-10.4.0 localization changes require republish of business objects

If version 3.5.x or higher is your first version of TRIRIGA Application Platform, please disregard this release
note. If you are upgrading from 3.4.x/10.4.x please read this release note. If you upgraded the platform to
3.4.x but did not also upgrade the application to 10.4.x, many business objects must be republished to
support localization changes.

You can do one of the two options. Make sure you do either option BEFORE the installation of TRIRIGA
Application Platform 3.5.0 or higher.

NEVER do either option after upgrading to 3.5.0 or higher.

Option 1: To republish all of the business objects, you can follow the instructions given in the
Publish_all_BOs_For_localization_MSSS.sql or Publish_all_BOs_For_localization_ORCL.sql scripts, which are
found in the scripts directory of the Application Upgrade disk. You use the ORCL script for DB2.

© Copyright IBM Corporation 2022. 11



Option 2: You can choose to manually republish the business objects. The following business objects, listed
with business object name first and module name in parentheses, need to be republished:

Classification (Classification)

Cost Code Container (triCostCode)

Data Utilities (Data Utilities)

Document Container (Document)
Geography (Geography)

Group (Group)

Group Member (Group)

Holidays (System)

Location (Location)

Organization (Organization)

Permission Line Item (triPeople)
Polylining Standard (Polylining Standard)
Project Group Container (Group)

ROOT (Document)

triAnalyticEvent (triAnalyticEvent)
triAnalyticItem (triAnalyticItem)
triAnalyticProcess (triAnalyticProcess)
triAnalyticRule (triAnalyticRule)
triApplicationSettings (triSetup)
triApproval (triRouting)

triApprovalRule (triSetup)

triAssetEvent (triAnalyticEvent)
triAssetLink (triAsset)

triBidResponse (triProposal)
triBuildingSystem (triBuildingSystem)
triBuildingSystemLink (triBuildingSystem)
triCatalog (triCatalog)

triCatalogLink (triCatalog)
triCiApplicationDefinition (triCiApplicationManager)
triCiAssociatedObiject (triCiApplicationManager)
triCiHierarchyNode (triCiHierarchyNode)
triContactRole (trilntermediate)

triContract (triContract)
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triContractLink (triContract)

triCostCode (triCostCode)

triCostItemLink (triCostItem)
triCTQAssessment (trilntermediate)
triDataAttributeItemIntermediate (trilntermediate)
triDesignLink (triDesign)
triEnergyRatingErrorLog (triLog)
triEnergyStarValidationItem (trilntermediate)
triExternalMailServer (System)
triGeographyLink (Geography)
trilnspectionLink (trilnspection)
trilnventoryLocation (trilnventoryLocation)
trilnventoryLocationLink (trilnventoryLocation)
triltemLink (triltem)

triKeySecurity (triKeySecurity)
triLeaseAbstract (triContract)
triLeaseAbstractAction (triActionForm)
triLocationEnergySpace (trilntermediate)
triLocationLink (Location)
triNotificationDetails (triRouting)
triOSCREUtil (Data Utilities)

triPeopleLink (triPeople)

triPermitLink (triPermit)

triPlan (triPlanning)

triPlannedSpace (Location)

triPlanning (triPlanning)
triPlanningConflictItem (triPlanningItem)
triPlanningEnvironment (triPlanning)
triPlanningPeriodItem (triPlanningItem)
triPlanningScopeltem (triPlanningItem)
triProductsAndServicesLink (triProductsAndServices)
triProjectCalcItem (triCalculationItem)
triProjectLink (triProject)

triProjectReport (triProgressReport)
triProjectUpdater (triActionForm)
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triREContractLocations (trilntermediate)
triRequest (triRequest)

triRequestLink (triRequest)
triReservationGroup (triSetup)

triResource (trilntermediate)
triRetailCompany (trilntermediate)

triReview (triActionForm)

triReviewer (trilntermediate)
triScheduleTask (triTask)
triSpaceForecastItem (triPlanningItem)
triSpaceForecastSurvey (triPlanning)
triSpacePlan (triPlanning)

triSpaceScenario (triPlanning)
triSpecificationLink (triSpecification)
triSurveyQuestionResponse (trilntermediate)
triTaskLink (triTask)
triTaskResourceAllocation (triTaskAllocation)
Working Hours (System)

(Tri-128841, Tri-128369)

Java Development Kit
See information specific to Windows and Linux below.

Restriction: GNU OpenJDK is not supported and will not work with IBM TRIRIGA and the IBM TRIRIGA
Application Platform installation program. The OpenJDK package should be completely uninstalled from the
server.

Windows:

The IBM TRIRIGA installer for Windows runs on an internally bundled JVM (IBM JDK 8). The IBM TRIRIGA
installer for Windows also allows you to install this bundled JVM on your local machine to use with the
TRIRIGA runtime.

Linux:

The Java Development Kit (JDK) must be installed before you run the IBM TRIRIGA Application Platform
installer. The JDK must be installed before you run the IBM TRIRIGA application. This can be downloaded at
https://developer.ibm.com/javasdk/downloads/sdk8/ and is licensed and appropriate for production use on
Linux and AIX. Java must be running during an IBM TRIRIGA Application Platform installation. You must set
the JAVA_HOME environment variable to the path of the JDK before you start the IBM TRIRIGA Application
Platform installation program.
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IBM TRIRIGA Supported Versions and IBM TRIRIGA
Application Platform Compatibility Matrix

The IBM TRIRIGA Supported Versions lists information related to IBM TRIRIGA’s supported products and
platform and relays information about end-of-life plans for such software. The IBM TRIRIGA Application
Platform Compatibility Matrix lists supported operating systems, databases, and related details for and about
the IBM TRIRIGA Application Platform and relays information about end-of-life plans for such software. The
IBM TRIRIGA Supported Versions and the IBM TRIRIGA Application Platform Compatibility Matrix may change
over time. The IBM TRIRIGA Supported Versions and the IBM TRIRIGA Application Platform Compatibility
Matrix can be found on IBM Support.

IMPORTANT NOTICES: IBM no longer supports IBM Tivoli Directory Integrator. Migrate your TDI assemblies
to a supported technology, such as Pentaho. As of version 3.7.0, the IBM TRIRIGA Application Platform no
longer ships with or supports TDI assemblies.

As communicated in the IBM TRIRIGA Application Platform 3.7.0 Compatibility Matrix, IBM does not support
Oracle WebLogic with IBM TRIRIGA Application Platform version 3.7.0 and later. Please see the Compatibility
Matrix for the full listing of compatible products and versions.

Effective April 3, 2021, IBM TRIRIGA no longer supports SAP Crystal Server on TRIRIGA versions, releases, or
modifications released after that date. Existing Crystal Reports will need to be converted to BIRT reporting or
other supported reporting alternative.
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IBM TRIRIGA Application Object Migration Packages

TRIRIGA delivers application object migration packages:

Incremental Package: Each application release is a separate file name TRIRIGA <version>.zip.
The latest incremental package is for IBM TRIRIGA 11.1.

For 11.1 application release, another object migration package,

TRIRIGA 11 1 SetupData 202205051444.zip, contains complete new sets of journal entry
event setup templates, journal entry setup templates and their input calculations. Each of the new
journal entry event setup template and journal entry setup template has the Template Version as
11.1. They will be created newly in your system. If you do not want to keep your existing journal entry
setup templates and journal entry setups, delete them, and confirm that they are deleted from your
database prior to applying this object migration package.

If you keep your existing journal entry setup templates, complete the following steps:

1.

Execute the patchhelper "triPatchHelper - triCalculate - 11.1 - Migrate Journal Entry Setup
Template to Event Based" for the string to be used. The Journal Entry Event Setup Templates

will be created for each of the Trigger Sub Type from the existing journal entry setup
templates. The journal entry event setup templates will now group all your journal entry
setup templates based on the trigger sub type.

If the journal entry event setup templates have the following Trigger Sub Type, make a copy
of each of them and on the copied record, set the Triger Sub Category = Catch up. This
journal entry event setup template will be used when the lease event is triggered
retroactively (prior to the current open period). This is for catching up periods.

Modification

Modification Decrease In Term
Modification Partial Termination
Modification Exceeds Asset
Modification Short Term to Long Term
Reclassification

Revert Gain/Loss

Impairment

IFRS Reversal Impairment
Index Adjustment
Abandonment

If the journal entry event setup templates have the following Trigger Sub Type, make a copy
of each of them and on the copied record, set the Triger Sub Category = Reversal. This
journal entry event setup template will be used when the lease event is triggered
retroactively (prior to the current open period). This is for reversing over-booking periods.

Termination
Abandonment
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IBM TRIRIGA 11.1

This release includes important information, known limitations, and changes to IBM TRIRIGA.

Important Information

The following item is important information concerning IBM TRIRIGA that is newly added for this release. For
Important Information related to previous releases, see the Release Notes page on IBM Support.

Area of Impact

UX Room Reservation
App

Description

If the reservation time exceeds the current date, the Check in button will not be
displayed in the UX Reserve Perceptive application. The Check in button is
available only when the reservation is done for the current date.
(Tri-71999-1331148)

Known Limitations

The following items are known limitations concerning IBM TRIRIGA that are newly added for this release. For
Known Limitations related to previous releases, see the Release Notes page on IBM Support.

Area of Impact Description

Amendments

Payment adjustments

Index clauses

Lease - Asset and Real
Estate

Lease - Asset and Real
Estate

Lease - Asset and Real
Estate

Lease - Asset and Real
Estate

When doing an amendment to adjust payments that are based on an index
lease, a user can only adjust payments using Update Action = Update or Split
Payment Schedules on the Payment Adjustment form to cause the variable
that results from the index to become a fixed payment.

When setting up an index lease with multiple index clauses, the system is
using the clause type to group the index clauses. This is for the purpose of
calculation comparison.

On RE Lease and Asset Lease forms, the Contact Role validation is performed.
However, on the validation failure the Attention section and the Attention

message is hidden for the users. Contact Customer Service portal for the fix.

TRIRIGA is not supported, when changing a business unit with a different
functional currency.

Journal Entry DTO contains only functional currency values.

The currency conversion for BIRT disclosure reports only supports the
‘Default’ currency conversion group.
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Area of Impact Description

Lease Accounting - GAAP TRIRIGA does not support cases where modification results in lease
reclassification from Finance lease to Operating lease.

Lease - Asset and Real Adjustments to an upfront incentive amount can be carried out by adjusting
Estate the incentive payment schedule and associated payment line item.

1. If the payment schedule start date is after today, use the Update or Split
Payment Schedules option to adjust incentive amount. Both the payment
schedule and payment line item will be adjusted.

2. If the payment schedule start date is before today, then two adjustments
should be made:

Step 1. Use the Update or Split Payment Schedules option to adjust the
incentive amount on the payment schedule.

Step 2. Use the Update Only Payment Line Items option to adjust the
incentive amount on the payment line item.

3. If the payment schedule start date is today and the payment line item is
not paid yet, use step 1 from above. If the payment schedule start date is
today and the payment line item is already paid, use step 2 from above.

Lease Accounting — GAAP  For separation of current and non-current assets and liabilities, segregation

and IFRS between short-term and long-term liability is available in the respective
accounting schedules in TRIRIGA. However, the disclosure reports do not
provide the segregation between short-term and long-term liability.

Lease Accounting — GAAP  Partial calculations of index adjustments are not currently supported.
and IFRS

(Limitation known since
10.5.3.1)

Lease Accounting — GAAP  The following limitations currently apply to incentive adjustments:

N AR Support for an adjustment of incentive amount is available only for incentive

(Limitation known since schedules added before activation.

10640 After adding new incentive schedule at the modification, any adjustment of

existing incentive schedules is not supported.

For an incentive schedule adjustment, both payment schedules and payment
line items should be separately adjusted.

A new incentive schedule that is added after the modification cannot have the
same date as an existing incentive payment schedule. If this happens, the
new incentive amount will not be included.

(Tri-52727-1J06586-1V99840)

Lease Accounting — GAAP = TRIRIGA currently supports only two asset types: Asset Lease and Real
and IFRS Estate Lease.
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Area of Impact

Description

(Limitation known since
10.6.0)

Lease Accounting — GAAP
and IFRS

Lease Accounting — GAAP
and IFRS

Lease Accounting — IFRS

Operating lease IAS17 to
IFRS16

Payment adjustments

People

Tooltips

UX Room Reservation App

UX Room Reservation App

UX Room Search Add-in

You cannot currently use TRIRIGA to modify a lease mid-month.

After you upgrade to TRIRIGA Application version 11.1, the existing BIRT
disclosure reports (created before 11.1) work. However, the new currency
conversion rates are not used to calculate values in the reports. The new
currency conversion rates are now stored in the new business object for
budget currency conversion, which is not used in the reports. For the reports
to use the new rates, you must customize them. Otherwise, the new set of
BIRT disclosure reports are available in 11.1.

TRIRIGA is not currently able to apply the recognition exemption under IFRS
16 associated with low value underlying assets, i.e. assets with a value of
$5,000 or less when new. Currently, TRIRIGA will recognize and measure
every lease irrespective of the value.

When transitioning a lease previously classified as an Operating lease under
IAS17 to IFRS16 with the modified retrospective approach, TRIRIGA
measures the ROU Asset using Option 2, referencing the KPMG guidance
(https://www.in.kpmg.com/ifrs/files/Leases-Transition-Options-Nov-
2016.pdf page 19). Option 2 measures the ROU asset at an amount equal to
the lease liability (subject to certain adjustments).

When doing a payment adjustment, the Update or Split Payment Schedules
option is not supported for one-time payment schedules. For incentive
schedule adjustment, you can create a separate one-time payment schedule

While using the profile to manage user points, you do not get feedback when
you run out of points. (Tri-74304)

Due to a third-party limitation, after clicking the Check more button and
hovering over the 'Switch to list' and 'Switch to floorplan' icons, the tooltips
are not displayed. (Tri-74099)

Room reservations cannot be edited when a room is released early or
checked out early. (Tri-73823)

In the Reservation perceptive app, due to a third-party limitation, after you
tap the Refresh icon on a mobile device, the screen is refreshed but the
'Refresh' tool tip is still shown. (Tri-72708)

After you upgrade the Outlook client for Mac to version 16.43, the Room
Search add-in ceases to add any room to a reservation with the Add Room
button. To resolve this issue, users must revert to the previous version of
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Area of Impact Description

Outlook. To switch back to the previous version of Outlook, in the new
Outlook client, set the New Outlook switch to on.

(Tri-70583)

UX Room Reservation App  In the React-based Reservation perceptive app, due to a third-party
limitation, the tooltip of the List icon may overlap and obscure that of the
Floor Plan icon. (Tri-69433)

UX Room Reservation App = Room reservations cannot be edited when a room is released early or
checked out early. (Tri-73823)

UX Work Task App After downloading a document attached to an asset from a work task in the
perceptive Work Task Management app, if the user returns to the Home page
by clicking the Home button and opens the work task again, the page freezes.
The workaround is to use the Back button of the browser instead of the Home
button in the app. (Tri-75101)

UX Room Search Add-in After you upgrade the Outlook client for Mac to version 16.43, the Room
Search add-in ceases to add any room to a reservation with the Add Room
button. To resolve this issue, users must revert to the previous version of
Outlook. To switch back to the previous version of Outlook, in the new
Outlook client, set the New Outlook switch to on.

(Tri-70583)

UX Room Reservation App  In the React-based Reservation perceptive app, due to a third-party
limitation, the tooltip of the List icon may overlap and obscure that of the
Floor Plan icon. (Tri-69433)

UX Work Task App After downloading a document attached to an asset from a work task in the
perceptive Work Task Management app, if the user returns to the Home page
by clicking the Home button and opens the work task again, the page freezes.
The workaround is to use the Back button of the browser instead of the Home
button in the app. (Tri-75101)

UX Room Search Add-in After you upgrade the Outlook client for Mac to version 16.43, the Room
Search add-in ceases to add any room to a reservation with the Add Room
button. To resolve this issue, users must revert to the previous version of
Outlook. To switch back to the previous version of Outlook, in the new
Outlook client, set the New Outlook switch to on.

(Tri-70583)

UX Work Task App After downloading a document attached to an asset from a work task in the
perceptive Work Task Management app, if the user returns to the Home page
by clicking the Home button and opens the work task again, the page freezes.
The workaround is to use the Back button of the browser instead of the Home
button in the app. (Tri-75101)
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IBM TRIRIGA 11.1 Changes

The following changes to IBM TRIRIGA are in this release:

Area of Change Description

Approvals For Facilities Project, approval is now routed to the respective roles set in the
approval templates. (Tri-77340-1J36127)

Approvals The approval process for the "Process Payments" BO has been updated.
System will now consider the sum of "Expected Amount with tax" from the
associated Payment line items as the Approval amount. (Tri-67651-1J26741)

Assets In an Asset record of any type, if the user tries to associate a new
specification record that has the same name as the existing associated
specification record, the system now correctly maps all the field values like
Spec ID, Make, Spec Class, Model Number, Description from the selected
specification record.

(Tri-71002-1330636)

Blanket Purchase There is no mismatch in the default values of Start and Expiration date fields

Order in the Blanket Purchase Order record. Both date fields will be populated with
the current date as a default value while trying to add a new Blanket Purchase
Order record. (Tri-74838-1333938)

Capital Project On Capital Project Template records, the '‘Budget Code Structure' field will not
go blank while saving the record. (Tri-69934-1J29831)

Capital Project The following security groups will now be able to access Find and Remove
actions, under Impact > Risk Items on the Issue Item Form.

e TRIRIGA Project Manager

e TRIRIGA Project Manager - Fundamentals

e TRIRIGA Application Administrator

e TRIRIGA Application Administrator - Fundamentals.

(Tri-77000)

Classifications Added the triTimezoneAbbrTX and triTimezoneAbbrDstTX fields to the Time
zones Classification module of triTimezone BO. The fields are added to the
Details section of the triTimeZones form. (Tri-74811)

Connector for BIM In an Integrated Revit model, when the footprint of a level (its total area) is
changed and the model is synced with TRIRIGA, the gross and measured area
of the floor is now correctly updated. (Tri-65820-1J24712)

Contracts The triModifiedBy field in the Cost Code and Building Equipment specification

records will be mapped to the user who updates the record.
(Tri-72154-1331158).
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Area of Change

Description

Data Modeler

Data Modeler

Data Modeler

Data Modeler

Facilities Projects

Form Builder

Form Builder

Form Builder

Graphics

Integration Object

Inventory

Lease — Asset

Lease — Asset

If you use the Find button for field search in any revised business object, the
Accept button will now be enabled and clearly visible. (Tri-66261)

Includes/Excludes on Business Object State Transition Sub actions will now
work as intended for the Option record. (Tri-62989-1J24893)

The Building records can be created with a Name field size of up to 1000
characters. (Tri-77347-1335960)

Locator fields where mapping is not defined in BO are mapped with Base BO
association definition and field "General: Name". (Tri-68198-1J27108)

In a Program record, for each Funding Request created for the Facilities
Project type, the "Total Funding" column is computed and displayed in the
Projects section inside the Program record. The Total Fund field is also visible
on the Facility Project record > Facilities Project Request > General >
Summary section. (Tri-79178-1J37826)

The Stack tab is removed from the Space Scenario form because Java applets
are no longer supported starting with 3.5.0 version of TRIRIGA Application
Platform. (Tri-77503)

The form validations were failing on the Organization -> Department form
because of the incorrect naming convention on the Organization Type field.
The name attribute had wrong mapping 'triorgTypeCL'. It is now corrected to
'triOrgTypeCL'". There will be no effect on the existing data; all the data will be
intact as the field is deleted from the form and added with correct name to
the form. (Tri-74569-1J33751)

The Stack tab is removed from the Work Plan form as the java applets do not
support the 3.5.0 platform version onwards. (Tri-78179)

In the Graphics Label section, while copying the label element of label
section, all the fields of the label element are copied, including extended
association fields. (Tri-70331-1J29438)

GIS Latitude and GIS Longitude fields are now auto populated; Geocoding is
successful. (Tri-69874)

In the Consumable Spec record, under the Inventory tab, associated
Inventory Transaction records are visible under the Inventory Transactions
query section. (Tri-76315-1J35161)

When an Asset Lease is modified, the Modification History section in the
History tab now displays the records. (Tri-67729)

Reverse association will now be created from the organization back to the
asset lease. (Tri-70222-1J29270)
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Area of Change Description

Lease — Asset When an Asset lease with an option reasonably certain at commencement is
copied, the copied lease no longer creates a duplicate Option record.
(Tri-73487)

Lease - Asset and After modification, the Fiscal Line Items are calculated correctly for leases

Real Estate that have a start date as 30th or 31st. (Tri-76915-1J35507)

Lease - Asset and Multiple contract attributes may be erroneously associated with a lease

Real Estate record. The extra contract attribute records will be deleted from the leases

when the PatchHelper workflow, triPatchHelper - triCalculate — 11.1_4 Batch
Process Leases, is run. There should only be 1 contract attribute associated
with the lease. The leases that have the status of Active, Revision In Progress,
Revision Accounting In Review, Review In Progress, Routing In Progress,
Terminated, Expired, and Retired will be included.

Note: Before triggering this PatchHelper, you must inform the users that they
should NOT revise their leases or make any other changes to their existing
leases until the updates are completed.

(Tri-71123-1330243)

Lease - Asset and While recording AR Receipts, the precision of the value of the sum amount

Real Estate under the Expected Amount column and under the Delta Amount column is
now the same. AR Receipts Delta Amount computation is now up to a
precision of two decimal places. (Tri-70390-1J29395)

Lease - Asset and During the modification of a lease, on the Contract Revision form, the user will
Real Estate not be able to select any fiscal period which is prior to the Accounting Start
Date or after the Accounting End Date. (Tri-70646-1J30333)

Lease - Asset and Multiple issues of GAAP & IFRS leases for the Negative ROUA scenario are
Real Estate now fixed.

e Scenario 1: Original lease + Full Impairment + perform modification
to reduce payments [For IFRS leases, Calculations for Gross Asset
Value & Accumulated Amortization are fixed]

e Scenario 2: Original lease + Perform modification to make lease
variable and reduce payments [For both GAAP & IFRS leases,
Calculations for Gross Asset Value & Accumulated Amortization are
fixed]

e Scenario 3: Original lease + Fully Impair + perform modification to
reduce space [For IFRS leases, Calculations for Gross Asset Value,
Accumulated Amortization & (Gain) Loss on Revaluation are fixed]

When the asset is already 0 and the adjustment to the asset at the
modification no longer reduces the gross asset further. Also, if the adjustment
to the asset is more than the current asset itself, the gross asset will now be
adjusted to the current asset amount. Both gross assets and accumulated
amortization are now calculated correctly.

(Tri-72874-1331960)
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Area of Change Description
Lease - Asset and Activate action will be hidden from the Contract Administrator when the
Real Estate Lease Accountant returns the lease after submitting it for Revision Accounting

In Review. (Tri-78357-1336880)

Lease - Asset and When a lease is amended after Accounting revise -> Data Revise, all the

Real Estate required sections are editable. (Tri-75183-1J34262)

Lease - Asset and When a lease is modified multiple times in the same period, accounting

Real Estate schedules are now calculated correctly. (Tri-70716-1J30730)

Lease - Asset and When payments are adjusted, the Catchup Payment also includes amounts of
Real Estate future paid payment line items. (Tri-76488-1J35210)

Lease - Asset and When a lease is terminated in the middle of the month using Prorated

Real Estate Payment Option, then the Amounts on Payment Line Item and Fiscal Line

Item are calculated correctly. (Tri-76206-1J35042)

Lease - Asset and After adjusting the payment schedules, the partial payment line items and
Real Estate catchup payment line items are generated correctly. (Tri-69670- 1J29039)
Lease - Asset and When a user performs a non-lease accounting amendment type revision, the
Real Estate Payment Schedules of Rent and Tenant Improvement Incentive types cannot

be voided. (Tri-78888-1337263)

Lease - Asset and When a lease is terminated and the Due Date of the terminated Payment Line
Real Estate Item is after the Termination Effective Date, then the Due Date is updated
with the Termination Effective Date. (Tri-75354-1J34801)

Lease - Asset and On activation of a lease, now only one email notification will be sent to the
Real Estate user. (Tri-76117-1335036)

Lease - Asset and Segment value errors on Journal Entry creation is now fixed for Department
Real Estate Accounting Cost Center and Division Accounting Cost Center.

(Tri-66837-1325603)

Lease - Asset and While modifying a lease with a reduction in term, the IFRS schedule on the
Real Estate Local tab or the Accounting tab includes a reduced ROU Asset value based on
the proportion of the number of periods reduced. (Tri-65793-1J25051)

Lease - Asset and Fields for Short Term Lease and Include In Amortization are added to the
Real Estate Local Reporting tab. This is to differentiate GAAP and IFRS in the case GAAP
is still short term, but IFRS is not.

A new straight-line schedule is visible if the lease is a short-term lease and
Include In Amortization is not checked. The schedule is also available on
Local Reporting.

Reassessment of Short Term lease after Modification:
GAAP(FASB): For a Short Term lease, when there is a change in lease term
either by an Option or by changing the Accounting End Date, if the remaining

© Copyright IBM Corporation 2022. 4



Area of Change Description

lease term extends for more than 12 months from the end of the previously-
determined lease term, the lease will not qualify as Short Term Lease.

IFRS (IASB): For a Short Term lease, on reassessment, if the likely term is
more than 12 months, the lease will not qualify as Short Term Lease.

When there is a modification and the lease is no longer a short term lease, the
transition/adjustments of IDC, Prepayment, Accrued Liability, etc. will be
included in the Operating/Finance schedule. (Tri-66912-1J25706)

Lease - Asset and Calculations of leases for less than a month are modified, and the asset value
Real Estate is coming down to zero for both Operating and Finance schedules.
(Tri-66179-1325249)

Lease - Asset and When a lease is terminated, the penalty amount now reflects on the Lease
Real Estate Schedule Summary section. Journal Entry templates are set up pointing to the
penalty amount. (Tri-65923-1J26208)

Lease - Asset and The Termination JE setup templates are corrected to close out the Liability,
Real Estate Gross Asset and Accumulated Amortization accounts. (Tri-64974-1J25046).
Lease - Asset and An error in the liability calculations for the JE 'Reclass Current to Long Term
Real Estate Liability" is now resolved. The number in the Nth Period from Calculation

Period should be 12 and not 11. (Tri-66249-1J26204)

Lease - Asset and Contract Revise Screen now opens even when both Base Lease Expiration
Real Estate Date and Accounting End Date are blank. (Tri-66859-1J26219)

Lease - Asset and The Expiration JE setup templates are corrected to close out the Liability,
Real Estate Gross Asset and Accumulated Amortization accounts. (Tri-64717-1J25049)
Lease - Asset and Tenant incentives added during the lease amendment will be treated in the
Real Estate same manner as they would be accounted for in connection with a new lease.

(Tri-66541-1J26141)

Lease - Asset and When selecting Contract Revise > Non-Lease-Accounting Amendment and

Real Estate then cancel it, sections and tabs on the lease are no longer editable.
(Tri-66348)

Lease - Asset and When performing an IFRS Impairment Reversal, the Interest Reduction is no

Real Estate longer resetting to zero (0). The amount remains the same. (Tri-73171)

Lease - Asset and NPV is no longer automatically recalculated after lease impairment.

Real Estate (Tri-70768-1330782)

Lease - Asset and The Schedule Summary section is now updated correctly after the Likely Term

Real Estate Purchase option was removed from both IFRS and GAAP Leases. (Tri-66970)

Lease - Asset and You can no longer create a lease with the Accounting End Date that is greater

Real Estate than the Base Lease Expiration Date when the lease has no renewal,

termination, or purchase option. Also, if there is a likely renewal, termination,
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Area of Change Description

or purchase option, the Accounting End Date cannot be greater than Renewal
Expiration Date, Likely Termination Execute Date, or Likely Purchase Execute
Date respectively.

If the Accounting End Date is greater than the Base Lease Expiration Date, an
error message will now show up to inform the lease accountant to update the
Accounting End Date. (Tri-72399)

Lease - Asset and The 'Is this a specialized asset?' question is moved from the Lease
Real Estate Classification section to the GAAP Classification section in both Accounting
and Local Reporting tabs. (Tri-70467-1J30801)

Lease - Asset and On Copying a lease with an option such as the lease renewal option, the
Real Estate copied lease option will now have the likely term end date and renewal
details.

(Tri-73999-1332971)

Lease - Asset and For a lease with the Accounting Standard IFRS (IASB) and Local Reporting

Real Estate enabled, if the lease classification of the Local Reporting tab is flipped from
Operating to Finance, the Current Asset Value is now calculated correctly.
(Tri-74516)

Lease - Asset and The system will no longer log the following warning on activation of the lease

Real Estate record: "Name of object being saved conflicts with existing object."

(Tri-78143-1336994)

Lease - Asset and Leases with a short period payment schedule will no longer get stuck in

Real Estate Processing on submit for accounting review. (Tri-74931)

Lease - Asset and If you log in as Contract Admin, you will be able to see the Unexpire button on
Real Estate an expired lease and the Unterminate button on a terminated lease.

You can unterminate or unexpire a lease only if the fiscal period of
Termination Effective Date or Expiration Effective Date and lease Current
Open Fiscal Period are same. (Tri-65569)

Lease - Asset and You can no longer perform an IFRS Reversal Impairment in the same period
Real Estate you performed the Full Impairment or IFRS Impairment. If you select the
same period, an error message is displayed. (Tri-76446)

Lease - Asset and When modifying a lease or issuing an index adjustment calculator, the Current
Real Estate Asset Value is now calculated correct (no longer 0) on an Accounts
Receivable lease. (Tri-69574-1J28715)

Lease - Asset and The Gain/Loss value is now cleared when the accounting schedule is
Real Estate populated by the reduction in term on an IFRS lease but then changed to

increase in term instead within the same modification. (Tri-77646)

Lease - Asset and When lease is impaired and the Accounting End Date is prorated, the liability
Real Estate value now comes down to zero. (Tri-74309-1333385)
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Lease - Asset and After you update payment instructions, duplicate payment instructions are no
Real Estate longer associated to a payment schedule. (Tri-74442-1J33313)

Lease - Asset and When performing an Amendment after Data Revise, the Calculate Lease

Real Estate Treatment and/or Recalculate NPV on the Treatment and Classification

sections are now visible. (Tri-66319-1J25148)

Lease - Asset and Post amendment if you click the Cancel button (close the form),
Real Estate the Accounting Start Date is made non-editable/read-only.

(Tri-66209-1325109)

Lease - Asset and Copy and Apply Template actions are visible under '‘More' after doing Data
Real Estate Revise/Non-Lease-Accounting Amendment. (Tri-66352)

Lease - Asset and Lease still qualifies as short term if likely term <= 12 months and initially it
Real Estate was short term=Yes. (Tri-66713)

Lease - Asset and On Contract Revise > Data Revise, Lease admin is able to 'Activate' the lease,
Real Estate instead of 'Submit for Accounting Review'. (Tri-65607)

Lease - Asset and A user message is displayed if the Accounting End Date is before the

Real Estate Accounting Start Date of the Lease. (Tri-65061-1J24752)

Lease - Asset and A new field 'Alternative Period' is added on Lease Journal Entry Calculation
Real Estate Period form.

Fiscal Period (of lease) from the Alternative Period is used in the Journal Entry
calculations if there is no Fiscal Period for the selected Calculation Period or
Cumulative From Period. (Tri-66060)

Lease - Asset and The history of a terminated lease includes the Termination effective date and

Real Estate the reason for termination. Similarly, the history of an expired lease includes
the Expiration effective date and the reason for expiration.
(Tri-67129-1326009)

Lease - Asset and When you remove/void a Tenant Improvement Incentive payment schedule

Real Estate during a lease amendment and re-calculate the accounting schedules, the
value of the voided payment schedule is removed from the Incentive
Schedule After Lease Commencement. (Tri-66872-1J25863)

Lease - Asset and The field size for some existing fields is now increased to 700.

Real Estate triContract>triSpaceUseAgreement : triNameTX
triRETransaction > triRETransactionTerms : triNameTX
triNotificationAction > triContractNotification : triNameTX
(Tri-65246-1J24272)

Lease - Asset and A warning prompt is displayed to the users to generate accounting schedules

Real Estate before a lease is activated if the same lease has been returned and no fiscal
line items are associated to the lease. (Tri-66017-1324828)
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Lease - Asset and On an active lease, after performing Contract Revise > Data Revise/Non-
Real Estate Lease-Accounting Amendment and clicking the Copy action, "Submit For

Accounting Review" is no longer visible.

On an active lease, after performing Accounting Revise > Data Revise and
clicking the Copy action, "Recalculate Accounting Schedules" is no longer
visible. (Tri-65890)

Lease - Asset and Fixed the issue where the old standard setting was not getting copied when

Real Estate doing JE Setup and JE Setup template copy. (Tri-67234)

Lease - Asset and The calculation for Interest Reduction on the accounting schedule is

Real Estate computed correctly now for a lease that has a lease incentive. (Tri-63848-
1J25104)

Lease - Asset and Lease Approvals will no longer be sent to the Retired employees after

Real Estate returning the lease. (Tri-65542-1J24743)

Lease - Asset and When a RE data change request is submitted or completed, a notification is

Real Estate now sent to the requester. (Tri-64935-1J24073)

Lease - Asset and The GAAP Classification section in the Local reporting tab of an IFRS Lease is

Real Estate now editable; the Lease Classification will give correct values. (Tri-66014)

Lease - Asset and Accounting Start Date is no longer cleared on Contract Revise > Non-Lease-

Real Estate Accounting Amendment. (Tri-66347-1J34830)

Lease - Asset and On clicking Unretire, leases with Terminated status now transitions to Active

Real Estate status and leases in Retired status transitions to the original state from when

it was retired. (Tri-61478-1J20132)

Lease - Asset and When a lease is returned/rejected by a legal user, the lease accountant now
Real Estate receives the notification and the status of the lease changes to 'Draft
Accounting in Review'. (Tri-66212-1J25014)

Lease - Asset and The Short Term lease field changes to No, when a Purchase Option is

Real Estate reasonably certain after a modification. (Tri-68330)

Lease - Asset and When a lease is terminated in the middle of the period, Gross Asset value
Real Estate remains unchanged. Accrued Interest Balance, Interest Reduction, Principal

Reduction, Short term Liability, Long Term Liability, and Accumulated
Amortization for the partial terminated FLI is recalculated.

(Tri-69059-1328540)
Lease - Asset and When Contract Revision is performed with the Contractual Factors:
Real Estate 1. Impairment to selected standard alone (GAAP or IFRS) is enabled

2. IFRS Impairment uses the new IFRS Impairment amount to compare with
asset value instead of Fair Market Value
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3. Full Impairment, GAAP Impairment, or IFRS impairment is selected, and all
other modification properties will be reset and read-only

4. For Impairment, NPV is no longer re-calculated

(Tri-71636)
Lease - Asset and The Purchase Option question, 'Is it reasonably certain at commencement
Real Estate date that the purchase option will be exercised at the end of the lease?', is

now read-only on the Accounting and Local Reporting tabs. On Initial lease,
for GAAP, the Purchase Option question is set to Yes if there is a reasonably
certain Purchase Option.

On the Initial lease, for GAAP and IFRS, the Transfer of Ownership question
("Does property transfer ownership at end of lease?") will be set to Yes if
there is a reasonably certain purchase option. Also, the IFRS Classification

section is now re-labeled as 'Other Information'. (Tri-67995)
Lease - Asset and When the Termination option is exercised, the Accounting End Date and Likely
Real Estate Expiration Date are now updated with the Termination Execute Date.
(Tri-72295)
Lease - Asset and The Gross Asset Value from the Modification Effective Period is now updated
Real Estate when Initial Direct Costs, Prepayment, and/or Tenant Incentive is added

before the Modification Effective Date while modifying. (Tri-73819)

Lease - Asset and While terminating a lease with Index Adjustment, the Index Adjustment
Real Estate calculators after the termination effective date are removed. (Tri-67870)
Lease - Asset and While performing 'Non-Lease-Accounting Amendment', the user actions will
Real Estate be limited.

(Tri-705

© Copyright IBM Corporation 2022.

Cannot generate/remove/update payment schedules with the
Summary Type 'Rent' and 'Include In Amortization' or 'Include In
Rental Prepayment' set to TRUE, or with the Summary Type
'Incentive' and 'Include In Upfront Incentive' set to TRUE.

Can update payment instructions for any payment schedule.

Can update the following sections on Options: Document Reference,
Comments, Notify Roles, Notify Within.

Can exercise reasonably certain options (that is, already set as likely
term option).

Cannot set an option as Likely Term and exercise any option which is
not reasonably certain (that is, likely term).

Can Add/Remove/Update any non-index clause.

Can update any sections on Index Clause, except Index Adjustments,
Payment Schedule, Options.

Cannot add/remove/update the Premise Locations section on the
Locations tab for RE Lease and Leased Assets section on the Assets
tab for Asset Lease.

92-1J30783)



Area of Change Description

Lease - Asset and On termination for Accounts Receivable leases, the termination payment line
Real Estate item is now created correctly. (Tri-77115)

Lease - Asset and The user message for the Reasonably Purchase Option is now corrected to
Real Estate show the following message.

“Is it reasonably certain at commencement date that the purchase option will
be exercised at the end of the lease?" is set to "No" in the GAAP Classification
section, but the purchase option is already reasonably certain. If you want to
update the answer, change the selection, and then click "Calculate Lease
Classification" again.” (Tri-74106)

Lease - Asset and The gain/loss calculated is now included in the Total Rent Expenses in the
Real Estate Schedule Summary section.

Note: The Total Rent Expenses field on the Schedule Summary section of the
Accounting tab and the Amortization Schedule section of the Local Reporting
tab will now get calculated/updated after the accounting schedule gets
generated or recalculated. It will no longer get calculated/updated along with
the NPV. (Tri- 78221)

Lease - Asset and The IFRS Impairment Reserve column is now visible in the IFRS Finance

Real Estate Schedule when the lease is an IFRS lease or GAAP lease with Local Reporting.
(Tri-73096)

Lease - Asset and The New Disclosure Reports will now bring the leases that have the status as

Real Estate Terminated and Expired. (Tri-71734)

Lease - Asset and Net Equity Values are calculated correctly after performing Impairment on

Real Estate the Local Reporting tab. (Tri-72927)

Lease - Asset and While using the Option wizard to create a termination option, the Likely

Real Estate Termination Execute date is now populated. (Tri-73556)

Lease - Asset and When a Purchase option is reasonably certain or exercised, the Accounting

Real Estate End Date and Likely Expiration Date are updated with the "Likely Purchase

Execute" field from the Purchase option. If the Likely Purchase Execute date
is prior to the Lease Expiration Date, the lease liability will now be amortized
to the Likely Purchase Execute date. (Tri-73965)

Lease - Asset and When a lease has an option reasonably certain, the history lease is now
Real Estate associated with the Likely option and the Accounting End Date is the same as
its original lease. (Tri-71139)

Lease - Asset and When a lease goes through Contract Revise->Amendment, the action buttons
Real Estate are present in the Options Record. (Tri-67888-1J26831)

Lease - Asset and Lease Classification Question, 'Does Property Transfer Ownership at End of
Real Estate Lease?' is visible for IFRS Lease. If it is set to Yes, then the lease is no longer

Short Term. (Tri-67566)
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Lease - Asset and For the IFRS Treatment section, when setting the question 'Does the lease
Real Estate substantially transfer all the risks and rewards incidental to ownership?’ to

Yes and later changing it to No, the questions under the Requirements section
are now set to default as No. (Tri-79148)

Lease - Asset and '‘Extend Rent Payments for Likely Term' field is now hidden in the Accounting
Real Estate tab. (Tri-68289)

Lease - Asset and The 10.6.0.4 PatchHelper workflow to update the Short Term and Long Term
Real Estate Liability is now updated to handle existing leases that were updated through

the index adjustment calculator so that the Long Term Liability is populated
with the correct amount. Also, the Short Term and Long Term Liability fields
on the Temporary History leases are now correctly populated.

(Tri-73661-1332678)

Lease - Asset and While modifying a lease with a Likely term option (Renewal, Termination), the
Real Estate IFRS schedule created on the Local tab includes a modified ROU Asset that is
now reduced based on the number of periods reduced. (Tri-70427-1J29441)

Lease - Asset and While activating a lease with a renewal option reasonably certain, the

Real Estate temporary history lease no longer shows the user message, "The Accounting
End Date must be before the Base Lease Expiration Date. To proceed, specify
an earlier Accounting End Date." (Tri-77809)

Lease - Asset and Renamed the Variable Lease Payment column to Variable Lease Payment
Real Estate (Index Only) in Accounting Schedules. (Tri-70464-1J30611)
Lease - Asset and The Accounting End Date is updated to Termination Execute Date when:

Real Estat . .
ealtstate » The Termination option is reasonably assured at the

inception/commencement/the first activation.
« The Termination option is exercised.

Other than the above scenarios, users can decide whether they want to
update the Accounting End Date to Termination Execute Date or not. An
attention message is displayed to remind the users that their Accounting End
Date is not updated to Termination Execute Date. (Tri-71077)

Lease - Asset and The Accounting Calendar field is no longer editable after the initial activation,
Real Estate except for a modification in the first period. (Tri-73196)

Lease - Asset and The Description field on RE Contract Revision, Asset Contract Revision, and
Real Estate Contract Revision forms will now accept up to 1000 characters. (Tri-72270)
Lease - Asset and Default Debit Account Code and Default Credit Account Code are now

Real Estate correctly updated from JE Setup to JE Setup Template through the "Apply

Record" action on JE Setup Template. Also Default Debit Account Code and
Default Credit Account Code are now correctly updated from JE Setup
Template to JE Setup through the "Apply Template" action on JE Setup.
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(Tri-67672)
Lease - Asset and The "Economic Life End" field on the Purchase Option is now hidden. The
Real Estate “Likely Purchase Execute" field is the date that now drives the lease liability

reduction. (Tri-73945)

Lease - Asset and For Accounts Receivable leases, users will be allowed to activate a lease only
Real Estate after the re-calculation of accounting schedules. Otherwise, an attention
message will be displayed. (Tri-77710-1J36342)

Lease - Asset and The value in the 'Amount Received' field of the Process AR Receipt form is
Real Estate now updated correctly based on the amount received. (Tri-70479)

Lease - Asset and The Local Reporting Required checkbox will be read-only after the first lease
Real Estate modification. If the lease is revised on the Original Accounting Start Period, it

will be available to select. (Tri- 72707)

Lease - Asset and When a lease is returned and a clause is added with min or max % increase,
Real Estate then the payment line items are adjusted. (Tri-68378-1J27198)

Lease - Asset and Updated the JE Setup Template for IFRS Impairment trigger to debit

Real Estate Gain/Loss and credit Impairment Reserve. (Tri-71417)

Lease - Asset and A lease is no longer stuck into processing after adding a short period Location
Real Estate Specific Quarterly Payment Schedule when the lease is amended.

(Tri-65274-1324238)

Lease - Asset and The TRIRIGA Lease Accountant, TRIRIGA Lease Accountant - Fundamentals,
Real Estate and TRIRIGA Local Lease Accountant groups now have access to Apply
Template action on Lease Journal Entry Setup form. (Tri-68499)

Lease - Asset and The Interest Reduction values on Accounting Schedules are now correctly
Real Estate calculated for both AP and AR leases when Payment Timing is “Payment in
Advance” or “Payment in Arrears”. (Tri-71274)

Lease - Asset and When an IFRS Impairment Reversal is performed, the Total Rent Expense,

Real Estate Current NPV, and Classification test PV in both FASB Treatment and Schedule
Summary of GAAP tab will remain unchanged. Also, the Total Rent Expense
and Current NPV remain the same for the IFRS tab. (Tri-72870)

Lease - Asset and Asset Class GL Code record can be created with either debit or credit account.
Real Estate (Tri-74861-1333850)

Lease - Asset and The system will no longer create duplicate Schedule Events records after
Real Estate clicking on activate action in the Real Estate Lease record.

(Tri-73504-1332801)

Lease - Asset and The Expected Expense Annual Amount field is added to the Payment
Real Estate Schedule which includes annual and tax amounts. (Tri-74530-1333749)
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Lease - Asset and When you remove/void the payment schedule during the lease amendment
Real Estate and re-calculate the accounting schedules, the variable adjustment amount

value of the voided payment schedule is removed from the Operating/Finance
schedule. (Tri-69831-1J28881)

Lease - Asset and Removed rounding of %Change & %Used in amount calculation of Index

Real Estate Adjustment Calculator. (Tri-72319-1331408)

Lease - Asset and The Dismantle Cost amount added at a modification is now included as part of
Real Estate the Gross Asset Value on the IFRS accounting schedule. (Tri-78209)

Lease - Asset and Warning lines are no longer generated in the server log when performing an
Real Estate Index Adjustment. (Tri-73048-1J32155)

Lease - Asset and Short Term Lease field on the history lease is now correctly populated as "No"
Real Estate when there is a likely purchase option at commencement. (Tri-68628)

Lease - Asset and Asset & RE Leases attention/user message workflows are updated with a new
Real Estate common call workflow. (Tri-79038)

Lease - Asset and A non-zero value in the Year of Adjustment field is required for clauses that
Real Estate include an Index Adjustment. (Tri-67393)

Lease - Asset and The Copy action of the Process Journal Entries record now copies the lease
Real Estate section correctly. (Tri-72628)

Lease - Asset and When the Accounting Start Date is in the middle of a fiscal period and is after
Real Estate the commencement date, on Amendment with the first period selected, the

Accounting Start Date is no longer updated. (Tri-64946-1J24239)

Lease - Asset and A patch helper workflow is created to fix the FLI calculation issue of impaired
Real Estate leases.

The patch helper updates the Gross Asset, Accumulated Amortization, and
Impairment Reserve fields for all the leases that are impaired in application
version 10.6.0.3 or before. Those fields will be updated on the history leases
of impaired leases as well.

Note: Before triggering this patch helper, please inform the users that they
should NOT revise their leases or do anything with their existing leases until
the updates are completed.

“triPatchHelper - triCalculate - 11.1_4 - Batch Process Leases ".
(Tri-77263-1335983)
Lease - Asset and The Short Term Lease and Include In Amortization fields are added to the

Real Estate Local Reporting tab. This is to separate the GAAP and IFRS in the case GAAP
is still short, but IFRS is not.
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« A new straight line schedule is visible if the lease is a Short Term lease and
Includes Amortization is not checked. The schedule is also there on the Local
Reporting.

« Reassessment of short term lease after Modification:

GAAP(FASB): For a Short Term lease, if there is a change in lease term either
by an Option or by changing the Accounting End Date if the remaining lease
term extends more than 12 months from the end of the previously-
determined lease term, the lease won't qualify as Short Term lease.

IFRS (IASB): For a Short Term lease, on reassessment, if the likely term is
more than 12 months the lease won't qualify as a Short Term lease.

» When there is a modification and the lease is no longer a Short Term lease,
the transition/adjustments of IDC, Prepayment, Accrued liability, and so on
will be included in the Operating/Finance schedule. (Tri-61926)

Lease - Asset and The Apply Record and Apply Template actions will update calculation inputs
Real Estate correctly in the Lease JE Setup record. (Tri-70345)

Lease - Asset and For IFRS reduction in a term, when an option exists on the lease before a
Real Estate modification, the following scenarios are considered as re-assessment and

NOT a modification. Therefore, the gain/loss calculated is no longer
populated. Also, the asset is adjusted based on the change in liability.

Scenario 1: A lease has a Termination option with Likely Termination Execute
before the Likely Term End Date. The option hasn’t yet been reasonably
certain before a modification. Later, the lease is modified to reasonably
certain on the Termination option.

Scenario 2: A lease has a Renewal option; the option is reasonably certain
before a modification. However, the lease is later modified to be NOT
reasonably certain on the renewal option. (Tri-77852)

Lease - Asset and The performance for processing date fields during Journal Entry creation is
Real Estate now improved. (Tri-69932-1J36799)

Lease - Asset and When a lease is amended multiple times in the same period, the

Real Estate reclassification of Accrued Interest Balance journal entries will no longer be

created while activating the lease for the second or later modification.
(Tri-70838-1J32566)
Lease - Asset and The header/title of the following portal sections, metric reports, and tabular
Real Estate reports has been changed to mention both GAAP and IFRS standards.
Portal sections
Chart - triFiscalLineltems - Asset Value - All FASB Governed Leases
Chart - triFiscalLineltems - Impact Report (Current Vs New FASB Standard)

Chart - triFiscalLineltems - Impact Report - Percent Increase (Current Vs New
FASB Standard)
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Metric and Tabular reports
triFiscalLineItem - Navigation - Asset Value - All FASB Governed Leases

triFiscalLineItem - Navigation - Asset Value - All FASB Governed Leases
(Tabular)

triFiscalLineltem - Navigation - Impact Report - All FASB Governed Leases

triFiscalLineltem - Navigation - Impact Report - All FASB Governed Leases
(Tabular)

triFiscalLineItem - Navigation - Percent Increase - All FASB Governed Leases

triFiscalLineItem - Navigation - Percent Increase - All FASB Governed Leases

(Tabular)

(Tri-68962)
Lease - Asset and When a fiscal period is modified, the fiscal payment summary and line items
Real Estate related to the fiscal period are re-calculated. (Tri-69034-1J28197)
Lease - Asset and Incentive After and Incentive Before Schedules will now be determined based
Real Estate on Accounting Start Date of the lease. (Tri-71090-1J32228)
Lease - Asset and On Accounting Revise when the user performs the Contractual Factors then
Real Estate the following Accounting Details section fields and sections on Accounting &

Local Reporting tab will be read-only. This results in removing the section
actions for Calculate Lease Treatments and Override Lease Classification.

1. Accounting tab--> Accounting Details section fields: Accounting End Date,
Accounting Type, Accounting Standard, Accounting Calendar, Payment
Timing; Sections: FASB Treatment section, IFRS Treatment section, GAAP
Classification section, IFRS Classification section, Lease Classification
section, Term Option section.

2. Local Reporting tab--> GAAP Classification section, Lease Classification
section.

(Tri-70667-1330944)

Lease - Asset and The “Include In Amortization” field in the Schedule Summary section will be
Real Estate read-only after Modification for Short Term lease. (Tri-65753)

Lease - Asset and Total rent and NPV are computed on the lease after submitting for accounting
Real Estate review for Short Term leases. (Tri-68420)

Lease - Asset and The Accounting End Date will be updated to include the renewal term, when:

Real Estate L : .
» Renewal option is reasonably assured at the inception/commencement/the
first activation.
« Renewal option is exercised.

Other than the above scenarios, users can decide whether they want to
include the renewal term or not by updating the Accounting End Date
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manually. An attention message is shown to remind the user that their
Accounting End Date is NOT matching/including the renewal term.

The Likely Expiration Date is updated when:

» Base Lease Expiration Date is manually entered or updated
» Renewal/Termination option is exercised

« Renewal/Termination option is reasonably certain (likely)

Following new fields are added for 842 Operating/Finance Schedules to
separate from 840 schedules: Unamortized Initial Direct Cost, Unamortized
Prepaid Rent, Unamortized Initial Direct Cost Liability, Unamortized Prepaid
Rent Liability, Incentive Expense, Incentive Expense After, Incentive Ending
Liability, Incentive Ending Liability After, Incentive Income and Incentive
Income After.

The fields on the 840 Schedule are calculated for the term of Accounting Start
Date to Accounting End Date. The fields on 842 schedules are calculated for
the term of Accounting Start Date/Modification Effective Date to Likely
Expiration Date.

The patch helper below is to update the new 842 Schedule fields for leases
that are in Active, Review In Progress, Routing In Progress, Revision In
Progress, and Revision Accounting In Review. For Active leases, those fields
will be updated on the temporary history lease as well. For the leases that are
in Draft Accounting In Review, the user will need to click on the Re-calculate
Accounting Schedule themselves to have the fields updated.

Note: Before triggering this patch helper, please inform users that they should
NOT revise their leases or do anything with their existing leases until the
updates are completed.

"triPatchHelper - triCalculate - 11.1_4 - Batch Process Leases".

(Tri-66389-1J28882)

Lease - Asset and The Net Equity for the IFRS reversal impairment period is now calculated
Real Estate correctly (net asset - liability). (Tri-71599)

Lease - Asset and Orphan payment instruction is no longer created while updating payment
Real Estate instruction. (Tri-76644-1335464)

Lease - Asset and When a lease without a Business Unit terminates in the middle of a past
Real Estate period (before the current calendar fiscal period), the 'Payment for Partial

Period?' field is now visible and enabled. (Tri-79531)

Lease - Asset and When a lease is partially impaired with expiration date in the middle of a

Real Estate period, the Net Asset Value now amortizes to zero. (Tri-74698)

Lease - Asset and Reporting section on the Fiscal Line Items is updated with changes in the field
Real Estate values on lease and the long lease name is also displayed on the tabular

report. (Tri-66326)
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Lease - Asset and Apply Record and Apply Template action will now update calculation inputs
Real Estate correctly. (Tri-68421)

Lease - Asset and When a lease is terminated prior to the current open period of the business
Real Estate unit, there are now Journal Entry Setup Templates to reverse the already

posted Journal Entries. The reversal Journal Entries will be created on the
current open period. (Tri-75640-1J35295)

Lease - Asset and While modifying a Real Estate lease with a reduction in Square feet or Space,
Real Estate the IFRS schedule on the Local tab or the Accounting tab includes a reduced
ROU Asset value based on the proportion of Square feet reduced.

While modifying an Asset lease with a reduction in the number of Assets, the
IFRS schedule on the Local tab or the Accounting tab includes a reduced ROU
Asset value based on the proportion of Assets reduced. (Tri-67643-1J29335)

Lease - Asset and The ownership question in the Local Reporting tab is now updated on setting
Real Estate ‘Local Reporting Required?' and on change of the same question from the
Accounting tab (ASC 842 or IFRS 16). (Tri - 68335)

Lease - Asset and "Does Property Transfer Ownership at End of Lease?" changes to No when
Real Estate Purchase Option is cleared from the Contract Revision form while modifying
the lease. (Tri-68629)

Lease - Asset and The gain/loss amount generated on partial termination is added to the

Real Estate accrued Liability column of an Operating lease. This fixes accounting
schedules calculation issue on multiple partial terminations. (Tri-69725-
1J28880)

Lease - Asset and The system no longer allows users to expire a lease with a reasonably certain

Real Estate option. An attention message will be displayed to inform the users to exercise

the option before expiring the lease. (Tri-74180)

Lease - Asset and The Ownership and Purchase Option questions on the Local Reporting tab are

Real Estate no longer linked to questions under IFRS/FASB Treatment section. (Tri-
68336)

Lease - Asset and The values of the Schedule Summary section are now updated correctly when

Real Estate an option is reasonably certain or not reasonably certain by a Lease

Accountant. (Tri-73686)

Lease - Asset and On clearing the Likely Term option from the Lease > Accounting > Term option
Real Estate section, the Accounting End Date is updated and mapped from the latest
history lease that does not have a reasonably certain option.
(Tri-68415)
Lease - Asset and The Unamortized Incentive Liability column is now calculated properly upon
Real Estate modification, and the Incentive Before Commencement section under the

Accounting tab is now available. (Tri - 72832)
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Lease - Asset and The Expiration Effective Date is read-only on the expiration pop-up form. The
Real Estate Expiration Effective Date should be the Lease Expiration date. The user is not

allowed to change this date. (Tri-74362)

Lease - Asset and When an asset is reduced to 0 and again extended, the asset value will come

Real Estate down to 0. The Gain/Loss from the previous modification gets deducted from
the net asset value; a Journal Entry gets created for this deducted amount.
(Tri-65244-1J25723)

Lease - Asset and When a lease is impaired, the FMV, IDC, and Recalculate NPV will now be
Real Estate read-only/invisible. (Tri-72538)

Lease - Asset and On clearing the Likely Term option from the Contract Revision form while
Real Estate modifying a lease, the Accounting End Date is reverted to the base lease

expiration date. (Tri-68627)

Lease - Asset and The question "Does Property Transfer Ownership at End of Lease?" changes

Real Estate to Yes, when the Purchase Option is reasonably certain after a modification.
Also, it will change to No when the Purchase Option is not reasonably certain.
(Tri-68331)

Lease - Asset and A lease accountant will now be able to activate a lease after it goes through a

Real Estate “Non-Lease-Accounting Amendment” where a non-rent payment schedule is

added, followed by a “Data Revise”. (Tri-79553-1J38048)

Lease - Asset and Expected Expense Annual Amount and Total Tax Amount fields are added on
Real Estate to First and Last Partial Payment Details on Payment Schedule which includes
annual and tax amount. (Tri-74988)

Lease - Asset and The Payment Schedule section of a pending payment schedule is now read-
Real Estate only. A user can no longer change anything. If the payment is created
incorrectly, delete it, and re-create a new one. (Tri-68489-1J27262)

Lease - Asset and In case of IFRS lease, the Gain is now populated on the (Gain) Loss on

Real Estate Revaluation column of the Finance schedule when the IFRS Reversal
Impairment is performed. The gain is the IFRS Reversal Impairment Amount
Allowed. (Tri-71489)

Lease - Asset and The field "Is Cost or Fair Market Value Determinable?" is no longer displayed

Real Estate under the Details section of the General tab on the Real Estate Lease form.
(Tri-71245)

Lease - Asset and All the shipping Journal Entry Setup Template records have the '‘Record

Real Estate Journal' field as checked by default. (Tri-71121)

Lease - Asset and When the Termination option is exercised, the Base Lease Expiration Date is

Real Estate now updated with Likely Termination Execute Date from the Option.
(Tri-70973)
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Lease - Asset and When Apply Template action is performed on the JE Setup Record and Apply
Real Estate Record action is performed on the JE Setup Template, the Asset Class

Account Code section will be displayed correctly based on the Use Asset
Specific GL Code boolean field value of the corresponding template or record
that is applied. (Tri-71361)

Lease - Asset and For Gross Lease, the Rent Component Assumptions section on the Payments

Real Estate tab is now visible. (TRI-66497)

Lease - Asset and The retrospectively terminated leases will now be included in the processing

Real Estate of JEs for the current open period. (Tri-71138)

Lease - Asset and The First column 'Fiscal period' is fixed in all the Finance Schedule and

Real Estate Operating Schedule query sections. (Tri-70373)

Lease - Asset and Added a new switch setting to Application Settings to hide the

Real Estate warning/confirmation message that is displayed when activating a lease.
(Tri-72618)

Lease - Asset and When Transfer of Ownership is selected as Yes, the ROU asset is equally

Real Estate amortized (straight lined) over Estimated Economic Life of Asset instead of

the lease term. (Tri-70522-1331140)

Lease - Asset and The initial Direct Cost amount added during the Lease Amendment will now
Real Estate be treated in the same manner as the Initial Direct Cost amount would be
accounted for in connection with a new lease. (Tri - 67390)

Lease - Asset and Lease Local Reporting Utility is designed for the leases to enable and

Real Estate populate the local reporting tab. Any Asset lease or Real Estate Lease which
does not have the Local Reporting Standard adopted can be used for this
utility. This is now available at Contracts > Contract Set Up > Data Utilities >
Lease Local Reporting Utility, and from the Lease Accounting Manager portal.
For more details, refer to the Lease Local Reporting Utility user guide.

(Tri-63891-1J22684)
Lease - Asset and After the mirror lease is approved, all the Journal Entries from Mirror lease

Real Estate will be copied and associated to the Main lease. The correct JE Segments are
now available. (Tri-I1J30892-71898)

Lease - Asset and When performing Non-Lease-Accounting Amendment, the section actions on

Real Estate Payment Schedules section of clauses are not hidden and allow
Find/Generate Payment Schedules except for the following type of payment
schedules:

1. With the Summary Type 'Rent' and 'Include In Amortization' or
'Include In Rental Prepayment' set to TRUE.

2. With the Summary Type 'Incentive' and 'Include In Upfront Incentive'
set to TRUE.
(Tri-76420-1335915)
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Lease - Asset and For amendments within the same period, Unamortized Initial Direct Cost
Real Estate Liability, Unamortized Prepaid Rent Liability, and Unamortized Incentive

Liability values are now calculated correctly. (Tri-75267)

Lease - Asset and When a purchase option is exercised without being reasonably certain, the
Real Estate asset value is now amortized over the useful life of asset. (Tri-74047)

Lease - Asset and On Non-Lease Accounting Amendment, for Rent and Incentive Payments, the
Real Estate non-accounting fields can be updated while performing the payment

adjustment. (Tri-73703-1J32747)

Lease - Asset and Total Rent Expense includes Initial Direct Costs, Incentives, Exit or Disposal

Real Estate Liability Carryover, and Prepayments for both IFRS and GAAP leases.
(Tri-73012)

Lease - Asset and Accounting End Date can now be set after the Base Lease Expiration Date.

Real Estate (Tri-71639)

Lease - Real Estate Include in Rental Prepayment and Include in Incentive Schedule check boxes
will be updated correctly in the Draft lease after activating the Lease abstract.
(Tri-65825)

Lease - Real Estate When a lease abstract is created and activated only with the payment

schedules (no clauses created), the resultant lease no longer has a Rent
Clause in it. (Tri-65438)

Lease - Real Estate When the Building Proration Rule is Balance To Contract, the Total Prorated
Area will now exclude Accounts Receivable (AR) Leases area value of type
Sublease and Third-Party lease. (Tri-67085-1J27798)

Lists System will now map numeral 1 to the "Line number" of the first 'Purchase
order line item' record that is created from the "Products and Services"
section action at Purchase order > Line Items Tab> PO Line Items Section.

(Tri-68264-1327094)

Locations Key rooms can now be selected and is highlighted with appropriate colors
while shuffling between floors. (Tri-70393-1J29809)

Locations If you change the name in the location record and click Save, the system will
also update the name in all the associated records. For example, primary
work location field of the Work task records and primary location field of
Asset records. (Tri-71814-1J30897)

Locations The 'Total Contractable Area' field on the Building record fetches the area

from the RE Lease and Owned Property Fee Agreement. The updated code
will not include agreements with the 'Sold' status. (Tri-79355-1J37861)
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Locations The Name field is now correctly populated when an organization is selected
for Occupancy Allocation and Chargeback Allocation sections in the Space
record. (Tri-72301-1J31535)

Locations On Floor > Allocation, 'Area Level Allocation' and 'Area Level Allocation
History' sections the Organization Name is displayed with the 'Allocated to
Organization' name. (Tri-78242-1J36544)

Locations On the Work Task form under the Resources tab, while adding the location
type resource record, the two fields- Name and Hierarchy Path are now
populating correctly from the selected Location record. (Tri-71501-1330586)

Locations Updated the editable state of this editable query from 'triRevision' to
‘triReview' to show results with status 'Review In Progress'.

(Tri-74167-1333134)

Locations For Property records, Gross Area, Rentable Area, and Usable Area will be
calculated after excluding retired building records.

Maintenance Locations associated with a specific Geography will be visible on the right-
side window under Portfolio>Geo/Location Hierarchy. (Tri-75492-1J34658)

Maintenance In the Maintenance Manager, under the Tasks and Projects tabs, you can now
add rows and save data through the Schedule view [Gantt section].

(Tri-71488-1331401)

Maintenance When users navigate to the Maintenance Landing Page, they will see their
created Job Plans associated with their organization in the '‘My Draft Job
Plans' and 'My Active Job Plans' portal sections. (Tri-76053-1J34971)

Maintenance The system will not block the Room/Space added to the Resource Downtime
Record if the Resource Downtime Record is in a Draft state. In such a
scenario, the Space records associated with the Resource Downtime record
will be available for reservations. (Tri-75400-1J34746)

Maintenance Preventive maintenance work task now populates the time zone of the work
location. Also, in case of a Service Request, the time zone of a work task now
matches the building's (work location's) time zone. If the time zone for the
building or work location is not available, it maps to the user profile.
(Tri-74596-1333877)

Maintenance Updated the manager query (triPMSchedule - triMaintenance - Manager
Query). Removed the unused Service Provider Lookup field from the column
and user filter of query. (Tri-74102-1333008)

Module — triFinancial Instead of modifying the module-level workflow "triFinancial - Associate -

triStatus - Create Notification Details", a similar BO-level workflow is created
with association changed from "Classified by triStatus" to "Current Status" on
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start task. Also, the "Create Task" in the newly created workflow is updated
with "In Memory Only" property selected to minimize record data creation.
(Tri-73381-1332912)

Move Requests The draft move requests are now loaded correctly in the card view of the
Group Move application. (Tri-74969)

Move Requests Move planners are now allowed to edit the comments on the Move services
requests. (Tri-72208-1J31115)

Move Requests The request record is now mapped correctly on the survey record.

(Tri-67334-1326217)

Navigation A new navigation for Core Definition record is now available at Inventory >
Manage Keys > Core Definitions. (Tri-67636)

Navigation Builder By clicking Tools > Data Utilities, you can now see the default Data Utilities
landing page. (Tri-69714-1328980)

Notifications For a reservation with requestable spaces, the email notification is now
successfully sent to the requestor. Earlier, on the Notification Content page,
from the Link Display Option list, if you selected a value other than "Read Only
Form", the requestor did not receive the notification. (Tri-77913-1J36397)

Organizations The system will identify duplicate "Contact Role" associated with any record
based on the Name and ID of the selected Contact & Name of the selected
Role. If the above parameters match the newly created, the system will
display a warning message and will not allow saving the contact role.

(Tri-71421-1330384)
Organizations The system does refresh 'Reporting' section of Division and Department

records if parent record for those records is changed with the help of 'Cut' and
'Paste’ functionality. (Tri-68920-1J27946)

People The unused cstDemoCharacterBL field in My Profile BO is deleted.
(Tri-78131)

Performance Orphan records from the out-of-box tables are removed. (Tri-79853)

Portals Watson Analytics connector is no longer supported, and the section has been

removed from portals and navigations. (Tri-69197-1J28619)

Procurement While creating a new receiving line item record via Home > Procurement >
Requisitions and Purchase Orders > Receipts record > Line item Tab > Line
Item query section > Add, the new receiving line item record will now be
created and associated to the parent receipt record only if the user clicks
Create on receiving the line item. (Tri-70668-1J30004)
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Procurement While capturing reading via Procedure Step of a task, the Reading log will be
associated with the existing "PM Reading Location/Asset" record of asset that
has the same job plan as in the task and the same Reading Class and Reading
Units as in Procedure Step. (Tri-70189-1J29206)

UX Framework When you search for a building in the Room Reservation app, VoiceOver for
iOS devices will now read the building name and the second line of the
address (including city, state, and country) all together. This also applies to
the building name and address on the new page (right before you click on
search).

(Tri-77770-1336543)

Outlook The recurring meetings are now correctly updated in Exchange when you use
the Microsoft Graph API to integrate TRIRIGA with cloud and hybrid Exchange
servers. (Tri-81235)

Outlook The recurring meetings are now correctly updated in Exchange when you use
the Microsoft Graph API to integrate TRIRIGA with cloud and hybrid Exchange
servers. (Tri-81240)

Outlook The recurring meetings are now correctly updated in Exchange when you use
Reservations the Microsoft Graph API to integrate TRIRIGA with cloud and hybrid Exchange
servers. (Tri-81239)

People The Sitemap field updated through my profile is now updating correctly in
employee records. (Tri-69776)

People Users that have been retired are now filtered out from Home > Tasks >
Manage Resources > My Team's Labor Details and My Team's Licenses and
Certifications portal sections.
Also, the system now correctly displays Licenses and Certifications
associated to specific people records. (Tri-67083-1J25969)

People Mapping changed for triModifiedByTX field under triPeople business object to
‘Record Name System'. This way the Modified By person name field in the
people record will always reference to the name of the person who modified
the record.

(Tri-73528-1J33348)

People The error message displayed while entering an invalid email address during a
user password reset is corrected. (Tri-79717)

People As synchronous workflows will not work on state transitions for Document
BO, updated/created asynchronous workflows to call the workflow
"Document - Synchronous - Module Level Validation" which updates the
triModifiedByTX field. (Tri-72495-1J31730)
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Projects For Capital Project records under the Budget tab, the budget code structure
field will be linked with the project cost code record. (Tri-70855-1J30244)

Purchase Order Line Now system populates correct value of field "PO Line Item Total - Completed
Item total Items" in the Form Service Agreement > General Tab > Cost Summary
Section. (Tri-68433-1J27608)

Procurement In Procurement, the Copy action is removed from the Receiving Line Item,
Return Line Item, Contract Invoice Line Item, and Invoice Line Item business
object. (Tri-71918)

Purchase Order Line The copy action is now removed for the purchase order line item.

ttem modified (Tri-71745-1330862)

Procurement In Procurement, the Copy action is removed from the Receiving Line Item,
Return Line Item, Contract Invoice Line Item, and Invoice Line Item business
object. (Tri-71918)

Real Estate When the user applies the project template to a RE Transaction Plan record,

Transaction Plan the related document links appear automatically under the Related Document
section of the Notes & Document tab; they no longer have to be manually
configured on the task after applying the project template file.

(Tri-75047-1334339)

Report Manager The cst action is now removed from following reports:
triPortfolioBudgetingTemplate - triPortfolioPlanning Manager Query,
triRatingSchedule - triActive - Editable. (Tri-79852)

Report Scheduler The report scheduler will send the scheduled reports to mail irrespective of
opening and closing associated event records. No asynchronous event will
stop the emails. (Tri-69242-1J30731)

Requests The comments added to the Service Request record in the Notes &
Documents tab can now be viewed in the respective Work Task record's
Notes & Documents tab. (Tri-77366-1135989)

Requests The Product Item specification name and class will be mapped correctly in
the Products Requested section on the Product Request record and in the
Cart section on the Material Select record. (Tri-76771-1335522).

Requests The 'Request is for' toggle on the Request record, which was not updating the
location details correctly, is fixed now. When a user creates the service
request, the primary location is populated as per user details, when we
change the 'Request is for' to another user, the location is updated as per
another user. If we again assign it to a logged-in user(me), the location detail
is populating as per logged-in user. (Tri-74343-1J33329)
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Requests In a Service Evaluation record associated with a Service Request record for a
system with multiple users of the same name (namesake user), the
notifications will be sent to the correct person and not their namesake.

(Tri-79394)

Requests A user message is displayed if it exists on the attention section of the Move
Request. On revising any request, such as service request, move request,
inspection request, and so on, if there is no request class associated with the
building for which the request is raised, the system automatically associates
all the request classes based on the request type.

For example: If a move request is raised, then on revising it if there is no
request class associated with the building for which the request is raised, the
system will automatically associate all the request classes (small move,
group move, individual move). (Tri-66558-1J25751)

Requests Now when a RE Data change request is created, a Contract Review task is also
Lease - Real Estate generated. The generated Contract Review task has a proper mapping of
Timezone, Calendar, and Contract values. (Tri-64915-1J24204)

Reservations The system will display the Reservation Instance records in tabular format
whenever the user tries to drill down through the data point of the metric
report "triReservationResourceDayFact - Metric - Room Utilization Metric".
The issue occurs when the user uses the Show by Filter as "Calendar Day". A
new query report is placed at the data point that will now render all the
Reservation Instance records. (Tri-72931-1333202)

Reservations For the reservations of recurring type that is set up initially with attendees but
without a room added, the system is now able to handle the updates done to
the individual occurrences while doing reservation modifications. Therefore,
for such recurring reservation, users are now allowed to update the room
details at a later point of time for individual meeting occurrences.
(Tri-76649-1335305)

Reservations Users will not be able to Accept or Reject the Cancelled Room via the old
Outlook Email Notification. Also, now the Resource Owner will Receive the
Notification whenever the Room Resource (requestable) Pending approval
has been canceled stating to ignore the previous approval mail.
(Tri-71733-1331157)

Reservations For a series reservation occurrence, if an exception reservation exists where
multiple food order are added, system will generate the purchase order
record for each food order. (Tri-75558-1J35117)

Reservations On updating Resource Downtime record, the respective start and end date is
now reflected on the associated offline resources/space records.

(Tri-76396-1335272)
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Reservations For a series reservation occurrence, if an exception reservation exists where
multiple food order are added, system will generate the purchase order
record for each food order. (Tri-76940)

Reservations The system will populate the reason in the Rejection Notification whenever
the Reservation Resource Record is rejected by the Resource Owner.

(Tri-70008-1330927)

Reservations The system will now be able to Cancel and Update the Reservation
Occurrence by importing .ics into Outlook for the Reservation Record
created/updated/cancelled via Native TRIRIGA and Room Reservation UX
app. (Tri-72103-1J29842)

Reservations On the Reservation Auto Cancellation process, the system will not trigger any
confirmation notification and only trigger the required auto cancel email to
the end user. (Tri-76214-1335173)

Reservations The concierge form now calculates the End Date correctly once the form is
reset. (Tri-65582-1324406)

Reservations The End Date field in the Reservation Manager record is now updated
correctly after performing Early End or Check-Out. (Tri-65281-1J24451)

Reservations If the first day of a recurring reservation is restricted by the reservation policy
parameters, the reservation will be declined only for that specific day and not
for all the recurrences. (Tri-79538)

Reservations System does not send the auto-cancellation email notification for the room
resources that are already Declined. (Tri-72816)

Reservations The "Conference Phone" field on Space is now correctly mapped to the Copy
record. (Tri-71107)

Security The User Name column has been removed from specific pages of the
application UI to avoid brute force attacks. (Tri-70868-1J32427)

State Transitions A new state "CLOSE" is added to the BO ‘WorkFlowActionItem’. The system
will no longer send any WorkFlowActionItem record to the unknown state.

(Tri-66534-1J27413)
System Setup Now the system will display a user message for password change as per

selected 'Optional Rule Requirements' in Tools > System Setup >System >
Password Setup. (Tri-68581-1J27359)

Tasks In the Inventory Transaction Item, when you issue multiple items, the total

quantity issued under work task (work task info tab, parts section) is now
being calculated properly. (Tri-71105-1J30303)
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Tasks TRIRIGA allows you to capture two different readings, for example, water
temperature and oil temperature, using the same unit of measure (UOM) via a
single work task.

A new query section, 'Procedure Steps for Reading', is added to the General
tab for preventative maintenance (PM) schedules based on readings. The
system filters PM schedules based on selected Procedure Steps for Reading
records, in case PM Schedules have the same Reading Classification and
Reading UOM.

The new field "Procedure step" has been added to PM Reading
Location/Asset Form > General Tab > Job Plan Section. The system will filter
PM Reading Location/Asset based on the Procedure Step field in cases where
PM reading records have the same Reading Class and Reading Units.

In cases where there are no Procedure Steps for the Reading record, the PM
schedules are filtered based on Reading Classification and Reading UOM.
Similarly, the PM Reading Location/Asset record is filtered based on the
Reading Class and Reading Units.

For example, there are two reading-based PM schedules, PS1 and PS2, in a
single job plan, JP1, where both the PM Schedules have Reading
Classification set to Temperature and Reading UOM set to degrees-
Fahrenheit. Under the query section Procedure Steps for Reading, PS1 has Oil
Temperature selected and PS2 has Water Temperature selected.

Scenario 1: If you want to capture the Water Temperature reading manually
for any asset with the help of JP1, then you must select Water Temperature
as the Procedure step on the PM Reading Location/Asset record. After the
reading log record is associated with the PM Reading, PM schedule PS2 will
be chosen by the system for further task creation, if applicable.

Scenario 2: If you capture reading for any asset via the Task Procedure Step
record, for example, a task procedure step named Water Temperature, then
the reading log created will be associated to that PM Reading Location/Asset
record that has job plan JP1, reading class of Temperature, reading unit of
degrees-Fahrenheit and procedure step of Water Temperature. If the system
does not find any reading with the procedure step Water Temperature, then
the system will associate a reading log to that PM Reading Location/Asset
record where the reading class is Temperature, reading unit is degrees
Fahrenheit, and procedure step is blank/null. (Tri-71821-1J30787)

Tasks In the case of Preventive Maintenance work task, when you add multiple
assets/locations in Job Plan and use the work procedure per
asset/location/task, giving some value to cost and time in the procedure. The
value is now being calculated as per the procedure (cost and time) and the
number of assets/locations. The same cost and time are being populated on
the Work task. For example, if you have two Assets with a value of $10 and 5
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hours, respectively, a total value of $20 and a time of 10 hrs is reflected on
Task. (Tri-74949-[1J34336)

Tasks Time entry record created through 'Task-> Time sheet' Date is now updated
with the start date of the Associated Pay Period. (Tri-71477-1J30564)

Tasks Planned Tasks associated with Asset records are visible under Asset-
>Maintenance->Task section. (Tri-74104-1332991)

Tasks On Revise of Purchase Order, no duplicate Purchase Order Line item gets
created and does not get associated to Work Task. (Tri-70870-1J30136)

Tasks Now the system does not create a work task for the first "PM Readings Log"
record of asset if the value of "Action Based On" under the Reading-based PM
schedule is 'Variance'. (Tri-68531-1J27692)

Tasks After activation of work task, procedure steps will be displayed under 'Active
Task Procedure Steps' section. (Tri-68982)

Tasks On the Time Entry record, two fields in the System tab, Modified By and
Workflow Modified Date/Time will not be updated if users don't want to update the
record data and click Close (X).
(Tri-73211-1332288)

Tasks On-Time Entry Record, two fields under the system tab: Modified By and
Workflow Modified Date/Time, will not be updated if the user does not wish to update
the record data and clicks on cancel ('X"). (Tri-73211-1332288)

UX Group Move App Add All process no longer calls the server periodically to create move line
items, the application waits until all move line items are created.
(Tri-70371-139436)

UX Perceptive Apps Users who are not added in the reservation policy are unable to a create
reservation when those rooms in the reservation policy are added. It will
show a warning message and the 'create reservation' button will be disabled.
(Tri-76911-1335946)

UX Room Reservation A reservation cannot be created unless details are provided in the Subject
App field. (Tri-76976-1J35551)

UX Room Reservation = The reservation record on Outlook will be updated and display the shortened
App time correctly if End Early option is executed on the meeting.
(Tri-73972-1333876)

UX Room Reservation  Fixed an issue on iPhone when swiping right, the VoiceOver feature loops on

App the details of the first reservation where there are multiple reservations in a
month. It now moves on and announces the next reservations.
(Tri-77951-1J36448)
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UX Room Reservation = The Date Time Format on the Reservation list page in the UX application is
App now fixed. (Tri-78100-1J36498)

UX Room Reservation  During the process of creating a reservation, when the room is on hold, a
App message pop up is now displayed in both Chrome and Firefox browsers.

(Tri-76761-1335805)

UX Room Reservation | The All Day reservation timings in the UX Reserve Perceptive application are

App now changed to 00:00 to 23:59, as per the Foundation application timings.
Earlier the All Day reservation timings were hardcoded in the application to
reserve the room from 08:00 AM to 08:PM. (Tri-77313-1J37158)

UX Room Reservation  On Polymer reserve app, room card details both on list page and booking
App page are now displayed properly. (Tri-79682)

UX Room Reservation | The issue where a user creates a reservation when the exchange is enabled,
App the room does not appear in the agenda view even after manually refreshing
it, is now resolved when the users have a unique outlook account. (Tri-77685)

UX Room Reservation  The My Profile record will now be retired when an employee (user) retires.
App The user will not be able to log in when the record is in the retired state.

(Tri-77566-1336995)

UX Service Request Spacing issue that might occur in localized versions of the comment section is
App now resolved. (Tri-74839-1J34224)

UX Service Request When a user creates a Service Request for 'Someone Else', the System

App Location and System Geography on the System tab of the Service Request will

now be mapped from the requested location whereas the System
Organization will be mapped from the organization of the '‘Requested For'
user.

(Tri-74676-1J34341)

UX Service Request The 'Remove Services' option is now working to remove a Request class from
App buildings. (Tri-69716-1J28856)
UX Stacking App Removed active records for Space Level Allocation are now visible in related

reports of the Chargeback Allocations section in Allocation tab of Space
record. (Tri-70827-1J29914)

UX Work Task App When viewing large number of WorkTask records in the Unassigned tab, the
data is now paginated to display 50 records per page. Scroller is able to fetch
further data while switching between different views. (Tri-75079-1J35111)

UX Work Task App Large number of WorkTask records in the In-progress, Completed, and Draft
tabs are now paginated and are loaded correctly without any delays.

(Tri-77912-1336486)
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UX Work Task App When filtering WorkTask records in different tabs, the filtered records are now
paginated to display 50 records per page. The filtered records do not render
any records that are not defined in the filter criteria. (Tri-77920-1J36478)

UX Work Task App WorkTasks can now be searched based on the status. (Tri-77026-1J35768)
UX Workplace The Floor Plan rendering issue in the Workplace Services Perceptive
Services App application is fixed. (Tri-75119-1J34605)

UX Room Reservation In areservation with food orders, the total cost of the food order will be
App discounted if the quantity value is in the range of ‘Discount Qty From’ and
‘Discount Qty To’ field values. (Tri-79043-1J37657)

Workflow Closing and reopening any type of asset record under Portfolio > Assets will
not show a warning message in a workflow instance if the value of the
Workflow Name Field (triShowHideDynWorkflowTX) is blank in the Dynamic
Workflow. (Tri-72769-1J31892)

Tasks While capturing reading via Procedure Step of a task, the Reading Log will be
associated to the existing "PM Reading Location/Asset" record of asset,
where Reading Class and Reading Units are same as in Procedure Step.

(Tri-68505-1J27828)

Reservations On modifying the existing 'recurring type' reservation wherein few of the
reservation instances are in completed status, the system will successfully
create and update the future reservation instances; and the updated
reservations will also be considered in the Downtime Search.

(Tri-78372-1337165)

Requests For Automatic Duplicate Search criteria on the request class, a new
"Associate Additional Asset & Location?" checkbox is added under the
Duplicate Search sub-tab of the General tab of the Request Class form. If you
select this checkbox, only the additional location and asset added to the
duplicate Service Requests will be associated to the original Work Task.
(Tri-73533-1J32956)

Work Task Resolved an issue where on using the 'Assign' and 'Auto Assign' actions in the
Management Responsible Organization Section on the General tab, the Work Task record
System would update the "Baseline" section based on the "Planned" section.
The 'Total Baseline Working Hours' field is now calculated correctly when
using the "Assign" and "Auto-Assign" actions.
(Tri-68141-1J30031)

Workflow No warnings will now be captured in Admin Console Error Log Files for
missing or invalid workflows that are called. (Tri-70710-1J29924)

Workflow Resolved the text export issue for the following workflows:
triEnvironmental - triBenchmark - OnChange - End Date Validation
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triProject - triFacilitiesProject - Synchronous - Commit the Applied Record
triActionForm - triPaymentAdjustment - Synchronous - Find Paid and Unpaid
PLIs

triPlanning - triPlanningManager - Synchronous - Selected Location Check
triContract - triRealEstateContract - Synchronous - GUI Change
triReservation - triReservationInstance - Synchronous - Resource Instances -
Service - Process Food Orders

The following workflow is no longer used and is deleted: triBudget - Any - De-
Associate - triCostCode (tv). Users need to delete the workflow manually in
their environment. (Tri-78711)

Workflow No errors will be captured in the Admin Console Error Logs file that mentions
"no transition exists" on a Notification helper BO record while transitioning
the record to the null state. (Tri-76166-1335260)

Reservations Corrected the workflow mapping.
Workflow: triReservationManager - Synchronous - Exceptions -
Create/Update Occurrences
Task: Create Occurrence
Removed the mapping from triPreviousStatusCL2. (Tri-69803-1J29409)

Work Task Time entry record created through 'Task-> Time sheet' is now correctly
Management updated with the resource for which the time sheet is being filled.

(Tri-71478-1330566)

Organizations The Reporting section details on child Organizations are now properly
updated on saving the Organization record. (Tri-71137-1J30245)

Reservations When the reservation gets rejected, the system will no longer send any check-
in reminder email notification related to the respective reservation.

(Tri-77279-1336227)
Reservations Updated workflow triReservationInstance - Synchronous - Util - Get Request

Class. The value of "triReserveEventLocationTypeLI" field in switch condition
has been updated from "Work Space" to "Workspace". (Tri-67932)

Work Task For Time Entry, action workflows are updated to use the same business
Management object. (Tri-68194-1J27000)

Work Task Floor common type spaces will get prorated out if the flooris a 100%
Management common. In such cases, the floor common area will be added to the building

common area and get prorated. (Tri-1J28585-68767)
Work Task On the Work task record > Resources > Service provider costs, the system

Management correctly maps currency in the newly added Service Provider cost record from
the currency mapped to the associated Work Task. (Tri-69390-1J28536)
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Work Task Currency symbols have been added to all the currencies available in the
Management system. (Tri-69388-1J28559)

IBM TRIRIGA 11.1 Patch Helper Workflows

Patch helper workflows correct the record data in your IBM TRIRIGA application. A patch helper workflow can
revise and update, bring new data records for a release, and recalculate records. The patch helper makes
necessary changes to your IBM TRIRIGA database. You apply the patch helper workflows for a release after
you install or upgrade to that release. Wait for one patch helper workflow to complete before you begin the
next. Some patch helper workflows can take a long time to complete.

Note: Many of the patch helpers included in this release have already been included in earlier fix packs, as
shown in the patch helper name. When you run the main 11.1 patch helper workflow, it determines which of
the other patch helper workflows have already been applied and does not re-run any that are already applied
to your system.

The following patch helper workflows are in this release:

Name Description

triPatchHelper - Synchronous - 11.1 - The 11.1 patch helper workflows will be triggered
Main Patch Helper automatically after the 11.1 OM package is finished importing.

This patch helper updates the application version record with
the upgraded date if an application version exists, otherwise, it
creates an application version record.

triPatchHelper - triCalculate - 11.1 -
Application Data - App Version

triPatchHelper - triCalculate - 11.1 -

Felietten Setings Deiuls Sets default values in the Application Settings record.

triPatchHelper - triCalculate - 11.1 - Create more patch helper records to make use multi-threading
Create Sub PatchHelpers feature.

Cascade read only has been enabled for Blanket Purchase

triPatchHelper - triCalculate - 11.1 - Order. The old process of making the dependent records
MAKE DEPENDENTS EDITABLE - Blanket  editable/read only through workflow is retired. This workflow
Purchase Order - Make Comments makes the comments dependent records on Blanket Purchase
Editable Order as editable. "11.1 MAKE DEPENDENTS EDITABLE" patch

helper string should be used.

Cascade read only has been enabled for Blanket Purchase

triPatchHelper - triCalculate - 11.1 - Order. The old process of making the dependent records
MAKE DEPENDENTS EDITABLE - editable/read only through workflow is retired. This workflow
BlanketPurchaseOrder - Make Contact makes the Contact Roles dependent records on Blanket
Roles Editable Purchase Order as editable. "11.1 MAKE DEPENDENTS

EDITABLE" patch helper string should be used.
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triPatchHelper - triCalculate - 11.1 -
MAKE DEPENDENTS EDITABLE - Dummy
Record

Makes insurance dependent records read only. "11.1 MAKE
DEPENDENTS EDITABLE" patch helper string should be used.

triPatchHelper - triCalculate - 11.1 - Makes real estate contract dependent records read only. "11.1
MAKE DEPENDENTS EDITABLE - Faulty MAKE DEPENDENTS EDITABLE" patch helper string should be
Record used.

Cascade read only has been enabled for Insurance. The old
process of making the dependent records editable/read only
through workflow is retired. This workflow makes the
comments dependent records on Insurance as editable. "11.1
MAKE DEPENDENTS EDITABLE" patch helper string should be
used.

triPatchHelper - triCalculate - 11.1 -
MAKE DEPENDENTS EDITABLE -
Insurance - Make Comments Editable

Cascade read only has been enabled for Insurance. The old
process of making the dependent records editable/read only
through workflow is retired. This workflow makes the Contact
Roles dependent records on Insurance as editable. "11.1
MAKE DEPENDENTS EDITABLE" patch helper string should be
used.

triPatchHelper - triCalculate - 11.1 -
MAKE DEPENDENTS EDITABLE -
Insurance - Make Contact Roles Editable

Cascade read only has been enabled for Location. The old
process of making the dependent records editable/read only
through workflow is retired. This workflow makes the Building
System dependent records on Location as editable. "11.1
MAKE DEPENDENTS EDITABLE" patch helper string should be
used.

triPatchHelper - triCalculate - 11.1 -
MAKE DEPENDENTS EDITABLE - Location
- Make Building System Item Editable

Cascade read only has been enabled for Location. The old
process of making the dependent records editable/read only
through workflow is retired. This workflow makes the
comments dependent records on Location as editable. "11.1
MAKE DEPENDENTS EDITABLE" patch helper string should be
used.

triPatchHelper - triCalculate - 11.1 -
MAKE DEPENDENTS EDITABLE - Location
- Make Comments Editable

Cascade read only has been enabled for Location. The old

triPatchHelper - triCalculate - 11.1 - process of making the dependent records editable/read only
MAKE DEPENDENTS EDITABLE - Location through workflow is retired. This workflow makes the Contact
- Make Contact Roles Editable Roles dependent records on Location as editable. "11.1 MAKE

DEPENDENTS EDITABLE" patch helper string should be used.

Cascade read only has been enabled for Location. The old
process of making the dependent records editable/read only
through workflow is retired. This workflow makes the Other
Address dependent records on Location as editable. "11.1
MAKE DEPENDENTS EDITABLE" patch helper string should be
used.

triPatchHelper - triCalculate - 11.1 -
MAKE DEPENDENTS EDITABLE - Location
- Make Other Address Editable
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Cascade read only has been enabled for Location. The old

triPatchHelper - triCalculate - 11.1 - process of making the dependent records editable/read only
MAKE DEPENDENTS EDITABLE - Location through workflow is retired. This workflow makes the Other
- Make Other Phone Editable Phone dependent records on Location as editable. "11.1 MAKE

DEPENDENTS EDITABLE" patch helper string should be used.

Cascade read only has been enabled for Organization. The old
process of making the dependent records editable/read only
through workflow is retired. This workflow makes the
comments dependent records on Organization as editable.
"11.1 MAKE DEPENDENTS EDITABLE" patch helper string
should be used.

triPatchHelper - triCalculate - 11.1 -
MAKE DEPENDENTS EDITABLE -
Organization- Make Comments Editable

Cascade read only has been enabled for Organization. The old

triPatchHelper - triCalculate - 11.1 - process of making the dependent records editable/read only

MAKE DEPENDENTS EDITABLE - through workflow is retired. This workflow makes the Contact

Organization- Make Contact Roles Roles dependent records on Organization as editable. "11.1

Editable MAKE DEPENDENTS EDITABLE" patch helper string should be
used.

Cascade read only has been enabled for Organization. The old

triPatchHelper - triCalculate - 11.1 - process of making the dependent records editable/read only

MAKE DEPENDENTS EDITABLE - through workflow is retired. This workflow makes the Other

Organization- Make Other Address Address dependent records on Organization as editable. "11.1

Editable MAKE DEPENDENTS EDITABLE" patch helper string should be
used.

Cascade read only has been enabled for Prime Contract. The
old process of making the dependent records editable/read
only through workflow is retired. This workflow makes the
comments dependent records on Prime Contract as editable.
"11.1 MAKE DEPENDENTS EDITABLE" patch helper string
should be used.

triPatchHelper - triCalculate - 11.1 -
MAKE DEPENDENTS EDITABLE - Prime
Contract - Make Comments Editable

Cascade read only has been enabled for Prime Contract. The
old process of making the dependent records editable/read
only through workflow is retired. This workflow makes the
Contact Roles dependent records on Prime Contract as
editable. "11.1 MAKE DEPENDENTS EDITABLE" patch helper
string should be used.

triPatchHelper - triCalculate - 11.1 -
MAKE DEPENDENTS EDITABLE - Prime
Contract - Make Contact Roles Editable

Cascade read only has been enabled for Prime Contract. The

triPatchHelper - triCalculate - 11.1 - old process of making the dependent records editable/read
MAKE DEPENDENTS EDITABLE - Prime only through workflow is retired. This workflow makes the
Contract - Make Contract Line Item Contact Line Item dependent records on Prime Contract as
Editable editable. "11.1 MAKE DEPENDENTS EDITABLE" patch helper

string should be used.
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Name Description

triPatchHelper - triCalculate - 11.1 -

MAKE DEPENDENTS EDITABLE - Prime

Contract - Make PCLineltems Editable

triPatchHelper - triCalculate - 11.1 -
MAKE DEPENDENTS EDITABLE -
PrimeContractChangeOrder - Make
Comments Editable

triPatchHelper - triCalculate - 11.1 -
MAKE DEPENDENTS EDITABLE -
PrimeContractChangeOrder - Make
Contact Roles Editable

triPatchHelper - triCalculate - 11.1 -
MAKE DEPENDENTS EDITABLE -
PrimeContractChangeOrder - Make
Contract Line Item Editable

triPatchHelper - triCalculate - 11.1 -
MAKE DEPENDENTS EDITABLE -
PrimeContractChangeOrder - Make
Forecast Line Item Summary Editable

triPatchHelper - triCalculate - 11.1 -
MAKE DEPENDENTS EDITABLE -
PrimeContractChangeOrder - Make PC
Line Items Editable

triPatchHelper - triCalculate - 11.1 -
MAKE DEPENDENTS EDITABLE -
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Cascade read only has been enabled for Prime Contract. The
old process of making the dependent records editable/read
only through workflow is retired. This workflow makes the
PCLineltems dependent records on Prime Contract as
editable. "11.1 MAKE DEPENDENTS EDITABLE" patch helper
string should be used.

Cascade read only has been enabled for
PrimeContractChangeOrder. The old process of making the
dependent records editable/read only through workflow is
retired. This workflow makes the comments dependent
records on PrimeContractChangeOrder as editable. "11.1
MAKE DEPENDENTS EDITABLE" patch helper string should be
used.

Cascade read only has been enabled for
PrimeContractChangeOrder. The old process of making the
dependent records editable/read only through workflow is
retired. This workflow makes the Contact Roles dependent
records on PrimeContractChangeOrder as editable. "11.1
MAKE DEPENDENTS EDITABLE" patch helper string should be
used.

Cascade read only has been enabled for
PrimeContractChangeOrder. The old process of making the
dependent records editable/read only through workflow is
retired. This workflow makes the Contact Line Item
dependent records on PrimeContractChangeOrder as editable.
"11.1 MAKE DEPENDENTS EDITABLE" patch helper string
should be used.

Cascade read only has been enabled for
PrimeContractChangeOrder. The old process of making the
dependent records editable/read only through workflow is
retired. This workflow makes the Forecast Line Item Summary
dependent records on PrimeContractChangeOrder as editable.
"11.1 MAKE DEPENDENTS EDITABLE" patch helper string
should be used.

Cascade read only has been enabled for
PrimeContractChangeOrder. The old process of making the
dependent records editable/read only through workflow is
retired. This workflow makes the PC Line Items dependent
records on PrimeContractChangeOrder as editable. "11.1
MAKE DEPENDENTS EDITABLE" patch helper string should be
used.

Cascade read only has been enabled for
PrimeContractChangeOrder. The old process of making the
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Name Description

PrimeContractChangeOrder - Make dependent records editable/read only through workflow is

PCChangeOrderLineltems Editable retired. This workflow makes the PCChangeOrderLineltems
dependent records on PrimeContractChangeOrder as editable.
"11.1 MAKE DEPENDENTS EDITABLE" patch helper string
should be used.

Cascade read only has been enabled for Procurement Card.

triPatchHelper - triCalculate - 11.1 - The old process of making the dependent records

MAKE DEPENDENTS EDITABLE - editable/read only through workflow is retired. This workflow
Procurement Card - Make Comments makes the comments dependent records on Procurement
Editable Card as editable. "11.1 MAKE DEPENDENTS EDITABLE" patch

helper string should be used.

Cascade read only has been enabled for Procurement Card.

triPatchHelper - triCalculate - 11.1 - The old process of making the dependent records

MAKE DEPENDENTS EDITABLE - editable/read only through workflow is retired. This workflow
Procurement Card - Make Contact Roles makes the Contact Roles dependent records on Procurement
Editable Card as editable. "11.1 MAKE DEPENDENTS EDITABLE" patch

helper string should be used.

Cascade read only has been enabled for Purchase Order. The

triPatchHelper - triCalculate - 11.1 - old process of making the dependent records editable/read
MAKE DEPENDENTS EDITABLE - only through workflow is retired. This workflow makes the
Purchase Order - Make Comments comments dependent records on Purchase Order as editable.
Editable "11.1 MAKE DEPENDENTS EDITABLE" patch helper string

should be used.

Cascade read only has been enabled for Purchase Order. The

triPatchHelper - triCalculate - 11.1 - old process of making the dependent records editable/read
MAKE DEPENDENTS EDITABLE - only through workflow is retired. This workflow makes the
Purchase Order - Make Contact Roles Contact Roles dependent records on Purchase Order as
Editable editable. "11.1 MAKE DEPENDENTS EDITABLE" patch helper

string should be used.

Cascade read only has been enabled for Purchase Order. The

triPatchHelper - triCalculate - 11.1 - old process of making the dependent records editable/read
MAKE DEPENDENTS EDITABLE - only through workflow is retired. This workflow makes the
Purchase Order - Make Purchase Order Purchase Order Line Item dependent records on Purchase
Line Item Editable Order as editable. "11.1 MAKE DEPENDENTS EDITABLE" patch

helper string should be used.

Cascade read only has been enabled for Purchase Requisition.

triPatchHelper - triCalculate - 11.1 - The old process of making the dependent records

MAKE DEPENDENTS EDITABLE - editable/read only through workflow is retired. This workflow
Purchase Requisition - Make Comments makes the Comments dependent records on Purchase
Editable Requisition as editable. "11.1 MAKE DEPENDENTS EDITABLE"

patch helper string should be used.

triPatchHelper - triCalculate - 11.1 - Cascade read only has been enabled for Purchase Requisition.
MAKE DEPENDENTS EDITABLE - The old process of making the dependent records
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Purchase Requisition - Make Contact editable/read only through workflow is retired. This workflow

Roles Editable makes the Comments dependent records on Purchase
Requisition as editable. "11.1 MAKE DEPENDENTS EDITABLE"
patch helper string should be used.

Cascade read only has been enabled for Purchase Requisition.

triPatchHelper - triCalculate - 11.1 - The old process of making the dependent records

MAKE DEPENDENTS EDITABLE - editable/read only through workflow is retired. This workflow
Purchase Requisition - Make Purchase makes the Comments dependent records on Purchase
Requisition Line Item Editable Requisition Line Item as editable. "11.1 MAKE DEPENDENTS

EDITABLE" patch helper string should be used.

Cascade read only has been enabled for Space Use

triPatchHelper - triCalculate - 11.1 - Agreement. The old process of making the dependent records
MAKE DEPENDENTS EDITABLE - Space editable/read only through workflow is retired. This workflow
Use Agreement - Make Comments makes the comments dependent records on Space Use

Editable Agreement as editable. "11.1 MAKE DEPENDENTS EDITABLE"

patch helper string should be used.

Cascade read only has been enabled for Space Use

triPatchHelper - triCalculate - 11.1 - Agreement. The old process of making the dependent records
MAKE DEPENDENTS EDITABLE - Space editable/read only through workflow is retired. This workflow
Use Agreement - Make Contact Roles makes the Contact Roles dependent records on Space Use

Editable Agreement as editable. "11.1 MAKE DEPENDENTS EDITABLE"

patch helper string should be used.

Cascade read only has been enabled for Standard Contract.

triPatchHelper - triCalculate - 11.1 - The old process of making the dependent records

MAKE DEPENDENTS EDITABLE - editable/read only through workflow is retired. This workflow
Standard Contract - Make Comments makes the comments dependent records on Standard
Editable Contract as editable. "11.1 MAKE DEPENDENTS EDITABLE"

patch helper string should be used.

Cascade read only has been enabled for Standard Contract.

triPatchHelper - triCalculate - 11.1 - The old process of making the dependent records

MAKE DEPENDENTS EDITABLE - editable/read only through workflow is retired. This workflow
Standard Contract - Make Contact Roles makes the Contact Roles dependent records on Standard
Editable Contract as editable. "11.1 MAKE DEPENDENTS EDITABLE"

patch helper string should be used.

Cascade read only has been enabled for Standard Contract.

triPatchHelper - triCalculate - 11.1 - The old process of making the dependent records

MAKE DEPENDENTS EDITABLE - editable/read only through workflow is retired. This workflow
Standard Contract - Make Contract Cost makes the Contact Cost Break Down Items dependent records
Break down Items Editable on Standard Contract as editable. "11.1 MAKE DEPENDENTS

EDITABLE" patch helper string should be used.

Cascade read only has been enabled for Standard Contract.
The old process of making the dependent records
editable/read only through workflow is retired. This workflow

triPatchHelper - triCalculate - 11.1 -
MAKE DEPENDENTS EDITABLE -
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Standard Contract - Make Contract Line

Item Editable

triPatchHelper - triCalculate - 11.1 -
MAKE DEPENDENTS EDITABLE -
StandardContractChangeOrder - Make
Change Order Cost Break down Items
Editable

triPatchHelper - triCalculate - 11.1 -
MAKE DEPENDENTS EDITABLE -
StandardContractChangeOrder - Make
Comments Editable

triPatchHelper - triCalculate - 11.1 -
MAKE DEPENDENTS EDITABLE -
StandardContractChangeOrder - Make
Contact Roles Editable

triPatchHelper - triCalculate - 11.1 -
MAKE DEPENDENTS EDITABLE -
StandardContractChangeOrder - Make

Contract Cost Break down Items Editable

triPatchHelper - triCalculate - 11.1 -
MAKE DEPENDENTS EDITABLE -
StandardContractChangeOrder - Make
Contract Line Item Editable

triPatchHelper - triCalculate - 11.1 -
MAKE DEPENDENTS EDITABLE -
Warranty - Make Comments Editable
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makes the Contact Line Item dependent records on Standard
Contract as editable. "11.1 MAKE DEPENDENTS EDITABLE"
patch helper string should be used.

Cascade read only has been enabled for
StandardContractChangeOrder. The old process of making the
dependent records editable/read only through workflow is
retired. This workflow makes the Change Order Cost Break
Down Items dependent records on
StandardContractChangeOrder as editable. "11.1 MAKE
DEPENDENTS EDITABLE" patch helper string should be used.

Cascade read only has been enabled for
StandardContractChangeOrder. The old process of making the
dependent records editable/read only through workflow is
retired. This workflow makes the Comments dependent
records on StandardContractChangeOrder as editable. "11.1
MAKE DEPENDENTS EDITABLE" patch helper string should be
used.

Cascade read only has been enabled for
StandardContractChangeOrder. The old process of making the
dependent records editable/read only through workflow is
retired. This workflow makes the Contact Roles dependent
records on StandardContractChangeOrder as editable. "11.1
MAKE DEPENDENTS EDITABLE" patch helper string should be
used.

Cascade read only has been enabled for
StandardContractChangeOrder. The old process of making the
dependent records editable/read only through workflow is
retired. This workflow makes the Contract Cost Break Down
Items dependent records on StandardContractChangeOrder as
editable. "11.1 MAKE DEPENDENTS EDITABLE" patch helper
string should be used.

Cascade read only has been enabled for
StandardContractChangeOrder. The old process of making the
dependent records editable/read only through workflow is
retired. This workflow makes the Contract Line Item
dependent records on StandardContractChangeOrder as
editable. "11.1 MAKE DEPENDENTS EDITABLE" patch helper
string should be used.

Cascade read only has been enabled for Warranty. The old
process of making the dependent records editable/read only
through workflow is retired. This workflow makes the
Comments dependent records on Warranty as editable. "11.1
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MAKE DEPENDENTS EDITABLE" patch helper string should be
used.

Cascade read only has been enabled for Warranty. The old
triPatchHelper - triCalculate - 11.1 - process of making the dependent records editable/read only
MAKE DEPENDENTS EDITABLE - through workflow is retired. This workflow makes the Contact
Warranty - Make Contact Roles Editable Roles dependent records on Warranty as editable. "11.1 MAKE

DEPENDENTS EDITABLE" patch helper string should be used.

Cascade read only has been enabled for triAssetLease. The
old process of making the dependent records editable/read
only through workflow is retired. This workflow makes the
Address dependent records on triAssetLease as editable.
"11.1 MAKE DEPENDENTS EDITABLE" patch helper string
should be used.

triPatchHelper - triCalculate - 11.1 -
MAKE DEPENDENTS EDITABLE -
triAssetLease - Make Address Editable

Cascade read only has been enabled for triAssetLease. The
old process of making the dependent records editable/read
only through workflow is retired. This workflow makes the
Approval dependent records on triAssetLease as editable.
"11.1 MAKE DEPENDENTS EDITABLE" patch helper string
should be used.

triPatchHelper - triCalculate - 11.1 -
MAKE DEPENDENTS EDITABLE -
triAssetLease - Make Approval Editable

Cascade read only has been enabled for triAssetLease. The
old process of making the dependent records editable/read
only through workflow is retired. This workflow makes the
Comments dependent records on triAssetLease as editable.
"11.1 MAKE DEPENDENTS EDITABLE" patch helper string
should be used.

triPatchHelper - triCalculate - 11.1 -
MAKE DEPENDENTS EDITABLE -
triAssetLease - Make Comments Editable

Cascade read only has been enabled for triAssetLease. The

triPatchHelper - triCalculate - 11.1 - old process of making the dependent records editable/read
MAKE DEPENDENTS EDITABLE - only through workflow is retired. This workflow makes the
triAssetLease - Make Contact Roles Contact Roles dependent records on triAssetLease as editable.
Editable "11.1 MAKE DEPENDENTS EDITABLE" patch helper string

should be used.

Cascade read only has been enabled for triAssetLease. The

triPatchHelper - triCalculate - 11.1 - old process of making the dependent records editable/read
MAKE DEPENDENTS EDITABLE - only through workflow is retired. This workflow makes the
triAssetLease - Make Contract Contract Notification dependent records on triAssetLease as
Notification Editable editable. "11.1 MAKE DEPENDENTS EDITABLE" patch helper

string should be used.

triPatchHelper - triCalculate - 11.1 - Cascade read only has been enabled for triAssetLease. The
MAKE DEPENDENTS EDITABLE - old process of making the dependent records editable/read
triAssetLease - Make Lease Clause only through workflow is retired. This workflow makes the
Editable Lease Clause dependent records on triAssetLease as editable.
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"11.1 MAKE DEPENDENTS EDITABLE" patch helper string
should be used.

Cascade read only has been enabled for triAssetLease. The
old process of making the dependent records editable/read
only through workflow is retired. This workflow makes the
Option dependent records on triAssetLease as editable. "11.1
MAKE DEPENDENTS EDITABLE" patch helper string should be
used.

triPatchHelper - triCalculate - 11.1 -
MAKE DEPENDENTS EDITABLE -
triAssetLease - Make Option Editable

Cascade read only has been enabled for triAssetLease. The

triPatchHelper - triCalculate - 11.1 - old process of making the dependent records editable/read
MAKE DEPENDENTS EDITABLE - only through workflow is retired. This workflow makes the
triAssetLease - Make Payment Schedule Payment Schedule dependent records on triAssetLease as
Editable editable. "11.1 MAKE DEPENDENTS EDITABLE" patch helper

string should be used.

Cascade read only has been enabled for triRealEstateContract.

triPatchHelper - triCalculate - 11.1 - The old process of making the dependent records

MAKE DEPENDENTS EDITABLE - editable/read only through workflow is retired. This workflow
triRealEstateContract - Make Approval makes the Approval dependent records on

Editable triRealEstateContract as editable. "11.1 MAKE DEPENDENTS

EDITABLE" patch helper string should be used.

Cascade read only has been enabled for triRealEstateContract.

triPatchHelper - triCalculate - 11.1 - The old process of making the dependent records
MAKE DEPENDENTS EDITABLE - editable/read only through workflow is retired. This workflow
triRealEstateContract - Make Client makes the Client Attributes dependent records on
Attributes Editable triRealEstateContract as editable. "11.1 MAKE DEPENDENTS

EDITABLE" patch helper string should be used.

Cascade read only has been enabled for triRealEstateContract.

triPatchHelper - triCalculate - 11.1 - The old process of making the dependent records

MAKE DEPENDENTS EDITABLE - editable/read only through workflow is retired. This workflow
triRealEstateContract - Make Comments = makes the Comments dependent records on

Editable triRealEstateContract as editable. "11.1 MAKE DEPENDENTS

EDITABLE" patch helper string should be used.

Cascade read only has been enabled for triRealEstateContract.

triPatchHelper - triCalculate - 11.1 - The old process of making the dependent records

MAKE DEPENDENTS EDITABLE - editable/read only through workflow is retired. This workflow
triRealEstateContract - Make Contact makes the Contact Roles dependent records on

Roles Editable triRealEstateContract as editable. "11.1 MAKE DEPENDENTS

EDITABLE" patch helper string should be used.

triPatchHelper - triCalculate - 11.1 - Cascade read only has been enabled for triRealEstateContract.
MAKE DEPENDENTS EDITABLE - The old process of making the dependent records
triRealEstateContract - Make Get Other  editable/read only through workflow is retired. This workflow
Dates Editable makes the Get Other Dates dependent records on
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triRealEstateContract as editable. "11.1 MAKE DEPENDENTS
EDITABLE" patch helper string should be used.

Cascade read only has been enabled for triRealEstateContract.

triPatchHelper - triCalculate - 11.1 - The old process of making the dependent records

MAKE DEPENDENTS EDITABLE - editable/read only through workflow is retired. This workflow
triRealEstateContract - Make Lease makes the Lease Clause dependent records on

Clause Editable triRealEstateContract as editable. "11.1 MAKE DEPENDENTS

EDITABLE" patch helper string should be used.

Cascade read only has been enabled for triRealEstateContract.

triPatchHelper - triCalculate - 11.1 - The old process of making the dependent records

MAKE DEPENDENTS EDITABLE - editable/read only through workflow is retired. This workflow
triRealEstateContract - Make Space Use makes the Space Use Agreement dependent records on
Agreement Editable triRealEstateContract as editable. "11.1 MAKE DEPENDENTS

EDITABLE" patch helper string should be used.

Creates unique Journal Entry Event Setup Template records
based on exiting Journal Entry Setup Template Records. " 11.1
- Update JE Event Template" patch helper string should be
used.

triPatchHelper - triCalculate - 11.1 -
Migrate Journal Entry Setup Template to
Event Based

Updates existing Calculation Source drop down list value
"Finance/Operating Schedule" to "Finance/Operating/Short
Term SL Schedule" for Journal Entry Variable Records

triPatchHelper - triCalculate - 11.1_1 -
Change Finance/Operating Schedule

Updates existing Calculation Source drop down list value
"Local Finance/Operating Schedule" to "Local
Finance/Operating/Short Term SL Schedule" for Journal Entry
Variable Records

triPatchHelper - triCalculate - 11.1_1 -
Change Local Finance/Operating
Schedule

triPatchHelper - triCalculate - 11.1_2 -
Make Functional Currency Required on
Business Unit

Makes Functional Currency Field required for all existing
Business Units.

triPatchHelper - triCalculate - 11.1_2 -
Migrate Journal Entry Setup to Event
Based

Creates unique Journal Entry Event Setup records based on
exiting Journal Entry Setup Records.

triPatchHelper - triCalculate - 11.1_2 -
Update Blank Value of Nth Period From
Cumulative From Period to Zero

Sets zero value to Nth Period From Cumulatitve From Peirod
field for existing records which contains blank value

triPatchHelper - triCalculate - 11.1_3 - Migrates existing Budget Currency Conversion table into New
Migrate Budget Currency Conversion Data Budget Currency Conversion Business Object Records.

Create separate patch helper records for every 2000 leases, to
make use multi-threading support. Example 11.1_4X1,
11.1_4X2 etc...

triPatchHelper - triCalculate - 11.1_4 -
Batch Process Leases
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triPatchHelper - triCalculate - 11.1_5 - Updates Accounting Calendar on Fiscal Month When fiscal
Update Accounting Calendar on Fiscal period is modified, the Fiscal payment summary and fiscal line
Period item's related to the fiscal period are recalculated.

triPatchHelper - triCalculate - 11.1_6 -

Update Approval Amount on Facility Sets zero value for Approval Amount for all existing facility

projects where approval amount is blank

project

triPatchHelper - triCalculate - 11.1_6 - Recalculates existing people records to populate modified by
Update Modified By On People with same people record.

triPatchHelper - triCalculate - 11.1_7 - Updates primary location of Asset records where location
Update Primary Location of Asset name not in sync.

triPatchHelper - triCalculate - 11.1_7- Updates primary location of work task records where location
Update Primary Location of Work Task name not in sync.

triPatchHelper - triProcess - 11.1_4X -
Run Patch helper with Data Rebuild Updates existing lease records for the retro fixes.
Helper
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IBM TRIRIGA Application Platform 4.1

This release includes important information, known limitations, changes, and property file changes to the IBM
TRIRIGA Application Platform.

Important Information

The following items are important information concerning the IBM TRIRIGA Application Platform that is newly
added for this release. For Important Information related to previous releases, see the Release Notes page on
IBM Support.

Area of Impact Description

Administrator Console =~ When you create a new TRIRIGA database, it is recommended to update the
default System Encryption Type from SHA-1 to SHA-2. By default, the TRIRIGA
user credentials are stored by using SHA-1 hashing algorithm. SHA-2 is better,
more secure encryption algorithm with a minimum digest (hash value) of 512 bits.

To update the system encryption type:

1. After initial startup, log in to the TRIRIGA Administration Console as a system
user.

2. From the left menu, click System Info and review the values under System
Encryption Type.

3. Change the value from SHA-1 to SHA-2 and click 'Update Encryption Type'
button to save changes.

4. Log out of the admin console.

5. Restart the application server and log in to the admin console to make sure that
the existing or new password is still working without any issues. (Tri-81498)

Reporting Resolved an issue with the queries run through enhanced query rendering grids
where the header filter value was not honored. The header filter values were
clearing out after the user entered an additional filter value in one of the Show
more filters fields and pressed Enter. (Tri-80268-1J39460)
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Known Limitations

The following items are known limitations concerning the IBM TRIRIGA Application Platform and are newly
added for this release. For Known Limitations related to previous releases, see the Release Notes page on
IBM Support.

Area of Impact Description

Administrator Console TRIRIGA TreeGrid verbose debug logging in both Gantt and Availability is not
working. (Tri-81502)

Installation For DB2 on Websphere Liberty, jdbcCollection="NULLIDR1" needs to be added to
the properties.db2.jcc in server.xml. This is necessary for performance
optimization. (Tri-80596)

Login There is a Chrome and Edge browser limitation where user auto-filled usernames
and passwords are not automatically enabling the continue button on the login
screen. (Tri-72065)

Login Page For the Safari browser, the login page responsive design might distort while
decreasing or increasing the window size and screen sizes 865 and above.
(Tri-75537)

Navigation The hamburger icon in the menu header displays when company level is disabled.

The hamburger icon is not needed in this scenario. (Tri-70419)

Navigation The side navigation menu option visible only on the sitemap page is not being
honored at runtime. (Tri-76285)

Navigation If no action is performed after logging into TRIRIGA and the session expires while
on the home page, after logging back in via the login dialog displayed, when the
user refreshes the home page, the TRIRIGA user session might be destroyed.

(Tri-74036)

Navigation Navigating to the login page in the same browser session where other windows
are open while still accessing TRIRIGA, might result in the TRIRIGA user session
being destroyed for those open windows. (Tri-73831)

Navigation On the Safari browser for RTL users, the far left button on the multi-session logout
dialog might appear truncated. (Tri-76034)

Navigation The following TRIRIGAWEB.properties setting is not correctly navigating the
specified logout page:
SSO_SINGLE_SIGN_OUT_REDIRECT_URL

The workaround is as follows:
SSO_SINGLE_SIGN_OUT_REDIRECT_URL=/p/websignon?redirectUrl=YOUR_SIG
N_OUT_URL

(Tri-74208-1334600)
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Area of Impact Description

Navigation For the Safari browser, the latest TRIRIGA favicon does not appear in the browser
title of the page/tab for the new window after clicking Open in New Window link.
(Tri-77135)

Navigation For best results with user profile images and enhanced navigation, the images

should have a square aspect ratio and be sized to 96 x 96 pixels. Other sizes are
supported, but the recommended size will provide the best results. (Tri-70209)

Navigation The Select Project link might still appear for users after the project license is
removed. (Tri-72300)

Navigation Clicking the home link after its session is terminated due to a multi-session logout
from another device, might result in a 'loading please wait' message and a
spinner, instead of a session expired message. (Tri-74439)

Navigation When you click the page title after clicking a portal section link, the breadcrumb
might go back to home instead of the correct navigation path in some scenarios.
(Tri-76222)

Navigation The tooltip for the hamburger icon in the menu header is not translated.
(Tri-69877)

Navigation After logging in via the session timeout login prompt, other browser windows,

and/or tabs still open, you might encounter a session timeout page if the next
user action after the login is on one of those pages. Most TRIRIGA pages will not
encounter this issue. Following is a list of product areas where the session
timeout might occur in the above scenario on some but not all of their respective
pages. There might be other areas that are not listed here.

Admin Console
Alternate Form builder
Budget Currency
Business Object properties and State Transition pages
Document Management
Flat Hierarchy
Hierarchy Tree

Label Manager

Object Label Manager
Performance Manager
Reserve

Scorecard

Security Groups

Style Manager
Workflow Mapping

(Tri-75057)

Navigation For the Safari browser, the latest favicon is not displaying in the browser page/tab
title. (Tri-75590)
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Area of Impact Description

People While using a profile to manage user points, you do not get feedback when you
run out of points. (Tri-74304)

Reporting The issue on enhanced query grids where the "No data to display" message did
not properly align is now resolved. The "No data to display" message will no
longer overlap the query header or filters. At times, the alignment might not be
perfectly centered, and in rare cases an overlap might still occur. This is due to a
third-party limitation with AG-Grid: https://github.com/ag-grid/ag-
grid/issues/2429. (Tri-75367-1J34728)

Reporting For users with a Date and Time format that includes a ZZZ timezone token, Data
and Time query filters might not display accurate results in certain scenarios if the
timezone part is entered into the filter value. (Tri-77134)

Reporting Text fields with Type field set to DateTime or Date type incorrectly show data in
milliseconds on the editable query results page. (Tri-54627-1J08888)

Reporting The wrap text feature on reports displayed via the enhanced query grid will
visually make grid row hights slightly smaller if the row height has been set to
64px. (Tri-74584)

Reporting In Safari, for the enhanced render query grid, the blue focus is displayed by
default on the first element in the row size drop-down menu when the menu is
selected. (Tri-74334)

Reporting The ellipses of the overflow menu for manager queries might appear truncated
when a record is open in the inline view from that manager query. (Tri-74402)

Reporting On reports rendered through an enhanced grid, a horizontal scroll appears at the
bottom of pinned columns even though visually a horizontal scroll is not
necessary. (Tri-71983)

Reporting For the Safari browser, entering values in the more filter feature on reports run
through the enhanced query grid might have a false positive of returning no
results. (Tri-77022)

Reporting For queries displayed in portal sections, the Apply and Clear filter links might
display in scenarios where there are no filters. (Tri-75024)

Reporting When filtering a Date and Time field on a TRIRIGA query, users might get
unexpected results if their user profile date-time format is;: MMMMM dd, yyyy
hh:mm a zzz, and they leave off the timezone part in their filter value. (Tri-74890)

Reservation -Browser = Strict Security Settings in Chrome and Edge browsers may prevent integration

compatibility from working properly. In future, configuration parameters will be added to TAS
to enable that functionality". (Tri-81242)
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Area of Impact Description

Security

After a TRIRIGA user session timeout, SSO users who click the Renew session
button might see an SSO authentication popup window automatically open and
close immediately before the session renews. (Tri-73614)

IBM TRIRIGA Application Platform 4.1 Changes

The following changes to the IBM TRIRIGA Application Platform are in this release:

Area of Change Description

Administrator Console

Administrator Console

Administrator Console

Administrator Console

Administrator Console

Capital Project

Currency Conversion

Resolved an issue where the server session timeout pop-up warning dialog was
not displayed within the SESSION_WARNING_THRESHOLD configured in the
TRIRIGAWEB.properties file. This is applicable when the
SESSION_WARNING_ENABLED property is set to Y in the
TRIRIGAWEB.properties file.

Note: Starting with platform 4.0, this feature will only operate if the TRIRIGA User
Session Timeout functionality is disabled in the TRIRIGA Administrator Console,
located at TRIRIGA Admin Console > System Info > TRIRIGA User Session >
Disable User Session Timeout checkbox. (Tri-77332-1J36134)

Users should be able to log in to the TRIRIGA Process Server Admin Console with
account ID in uppercase even though the following setting is set to ‘N’:
USERNAME_CASE_SENSITIVE = N (Tri-73883-1J32902)

The In Memory Smart Object debugging mode drop-down selector is now located
in the Administrator Console on the Workflow Agent Info page.
(Tri-75647)

In TAS, the License Manager has been updated to show the remaining points and
license costs. (Tri-78843)

In TAS, the Licenses for Application Suite tab in the Admin Console, has been
updated to better show points usage per product/license and to make the
consumption of points more understandable to the administrator. (Tri-78844)

The Select Project link and Recent Project are now displayed on the company
home page after the user logs out and logs in again within the project context.
(Tri-78441-13837237)

After the environment is upgraded to 11.1, the Budget Currency Conversions are
record data, are available in reports, and use forms for display. If you delete a
record that is active or historical from the Budget Currency Conversion Manager, it
will appear to be deleted, but will not get deleted. Refreshing the query will return
the record. You can only delete Budget Currency Conversions that are not yet
active or are not historical. (Tri-71791)

© Copyright IBM Corporation 2022. 47



Currency Items The taglibs-standard-impl JAR file has been upgraded. (Tri-62129)
Currency Items The xmlbeans JAR file has been upgraded. (Tri- 75124)

Currency Items The batik JAR file has been upgraded. (Tri- 75125)

Currency Items The cxf-core JAR file has been upgraded. (Tri- 75126)

Currency Items The fluent-hc JAR file has been upgraded. (Tri-75157)

Currency Items The jstl JAR file has been upgraded. (Tri-62128)

Currency Items The mpxj JAR file has been upgraded. (Tri-75123)

Currency Items The ognl JAR file has been upgraded. (Tri-62134)

Currency Items The jackson-databind JAR file has been upgraded. (Tri-75128)

Currency Items The db2jcc4 JAR file has been upgraded. (Tri-75127)

Currency Items The dom4j JAR file has been upgraded. (Tri-62090)

Currency Update The common-io jar file is upgraded to the latest version. (Tri-76066)
Currency Update The hibernate-validator jar file is upgraded to the latest version. (Tri-75435)
Currency Update TreeGrid has been updated to 16.02.01. (Tri-64167)

Currency Update Log4J has been updated to Log4j-2.17.2. Alllog4j-1 components have been

removed. (Tri-79207)

Currency TRIRIGA Administrators will notice the following differences in the Platform

Administrator Console logging functionality after the migration to log4j2

e The name for the active log file will no longer contain the date, it will
simply be of the form <log_name>.log for example the active security log
file will be named security.log

e Any customizations that customers have made to the log4j.xml will need
to be re-applied to the log4j2.xml. Make sure to follow the xml
configurations specified by apache here:

https://logging.apache.org/log4j/2.x/manual/appenders.html

e  When log files automatically roll over nightly the year, month, and day will
be appended to rolled log in the following format:

<log_name>-yyyy-MM-dd.log

For example when the server log rolls over at midnight, the active log file will now
be server.log and yesterday’s log file would be server-2022-05-21.log
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Area of Change Description

The frequency of automatic rollover and the naming convention of the log files is
configurable in the log4j2.xml. For more info on configuring the rolling features of
the RollingRandomAccessFile appenders please visit the following link:

https://logging.apache.org/log4j/2.x/manual/appenders.html

e When a user manually rolls a log file a time suffix (an underscore followed
by the hour, minute, second, and milliseconds) will be appended to the
file pattern specified in the log4j2.xml. For out of the box installations
this would look like:

<log_name>-yyyy-MM-dd_HH-mm-ss-SSS.log

For example after rolling the server log the active log will server.log be and the
rolled log would be server-2022-05-21_9-25-56-001.log

This time suffix is not currently configurable in the log4j2.xml

(Tri-79361)
Document When setting permissions for Folders in Document Manager, the propagation
Management settings under the Permissions tab will now be accurately processed. "Propagate

them to all child folders, documents, and publications" will now properly
propagate the permissions to folders, documents, and publications. Additionally,
an issue has been resolved where permissions might have been propagated to
documents when "Propagate them to child folders only" was selected.

(Tri-74754-1333882)

Document After creating a capital project and applying template to generate document
Management hierarchy automatically, the hierarchy is now synchronizing properly across
multiple servers. (Tri-78729-1J38290)

GIS Resolved an issue with TRIRIGA and Esri integration where layers other than
TileLayers were not getting displayed. (Tri-73764-1J35345)

GIS A TRIRIGA Esri integration issue around large number of pins causing slow
performance of Esri maps is now improved. Pins will no longer re-draw
themselves on zoom in/zoom out, or when dragging the map. Pins will no longer
appear in individual layers when viewing the Show Options tab. The issue related
to Open Record link on the pin detail window not opening the record when clicked
is also resolved. (Tri-74810)

Gantt Task hierarchy is showing up correctly on the Gantt chart now.
(Tri-70745-1330383)

Integration OSLC Resource Manager will now work properly, even if there is another BO with
the same name as the selected BO. (Tri-74726-1J35149)

Integration Object A new field, Query Batch Size is now added to the Integration Object outbound file
scheme that allows control of the internal result batching Integration Object with
TRIRIGA queries. By default, query data is incrementally processed by
Integration Object in batches of 999 records until all results are written to the
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Area of Change Description

output location. This default batch size is intended to prevent potential memory
issues on the TRIRIGA servers. Use the Query Batch Size field to adjust the batch
size (-1 will not batch the query data). This setting should be used with caution as
it can impact the performance of the TRIRIGA servers.

Note: For the Integration Object records that run via Workflow tasks, the
maximum batch size will be 2000 when passing the record filter values into the
CustomTask parameter due to SQL limitations with the number of values in an IN
clause.

Additionally, for the JSON and XML export file types, the “Exceed 999 Result Limit
and Return Maximum?" check box " is now re-labeled as “Do Not Limit Results to
First Batch?". The functionality remains the same as per the prior releases, but
the new label is more compatible with the new Query Batch Size field. (Tri-
76839-1J35520)

Lease - Real Estate Export data from any report is now working properly for multiple attempts.
(Tri-74143)
Licensing New BIRT reports have been created to provide TAS license usage.

triLicense - BIRT - Daily TAS License Usage Report for Selected Month
triLicense - BIRT - Daily TAS User Load Report for Selected Month
triLicense - BIRT - Hourly TAS License Usage Report for Selected Day
triLicense - BIRT - Hourly TAS User Load Report for Selected Day
triLicense - BIRT - Monthly TAS License Usage Report for Selected Year
triLicense - BIRT - Monthly TAS User Load Report for Selected Year
(Tri-71710)

Licensing The following BIRT reports have been updated to exclude the TAS licenses.
There are separate BIRT reports for TAS licenses.
triLicense - BIRT - Daily License Usage Report for Selected Month
triLicense - BIRT - Hourly License Usage Report for Selected Day
triLicense - BIRT - Monthly License Usage Report for Selected Year
(Tri-79579)

Login Resolved an issue where the session expiration login prompt displayed an invalid
login username for the system user. (Tri-72512)

MLA Converter The Platform fix pack installer has been updated to deliver the Module-Level
Associations (MLA) converter. (Tri-75088-1J34608)

Navigation Resolved an issue where not all menu items in the side navigation had a
consistent hover background color. (Tri-78800)

Navigation Resolved an issue where UX Applications with the component type of WEB_APP
were not correctly displayed when used via a Navigation Item. (Tri-79175)
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Area of Change Description

Navigation Side navigation menus, sitemap style pages, project sub-menu, and breadcrumbs
can now be opened in a new window or tab of a browser by using right-click.
(Tri-75342)

Navigation When you delete Security Groups, they will now be removed from any Navigation

Builder Group override that they are part of and also from the Navigation Builder
Group override drop down list. (Tri-67191-1J26207)

Navigation The core platform owned UX Applications will no longer appear in Navigation
Builder's Navigation Item Application drop-down. (Tri-79438)

Navigation If you click the Cancel button on the legacy session timeout dialog, you will now
be logged out of the session and then, redirected to the login page.
(Tri-78064)

Object Migration Performance improvements around creating Object Migration packages by date

and Object Migration search functionality for type Application and type Web
Component are now available. (Tri-77849)

Object Migration The default value for a date or date time field in a business object will now be
imported correctly in Object Migration. (Tri-76313-1J35808)

People With Application 11.1, when the Employee record is retired, the user (MyProfile)
record is retired instead of being deleted. This will allow continued audit tracking.
The platform has updated to make sure a Retired user cannot log in. For the
complete fix for APAR 1336995, the 11.1 application is required. (Tri-78828)

Portals Resolved an issue where when viewing portal section queries with related reports
in accessibility mode, the Add To Bookmarks button was incorrectly showing up
after a related report was selected. (Tri-75407-1J354006)

Portals Per IBM design guidance, UX Applications that are configured to not openin a
new window, will be contained within the TRIRIGA navigation but will not display
the bookmark or open in new window action bar in their header.

Additionally, when UX Applications that are configured in this way are opened in a
new window or new tab by using the browser open in new w\indow or new tab
options, the UX Applications will open outside of the TRIRIGA navigation
container.

Note, UX Applications that are used as a user portal home page will still show the
bookmark / open in new window action bar in their header. (Tri-78032)

Portals The query portal sections using the enhanced rendering grid will now honor the
result size setting in portal section builder. The result size will be honored when
set to below 100.

Note: The pagination footer will remain, so that the users can paginate through
the results. (Tri-78870- 1337279)
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Area of Change Description

Record Runtime The default Time value defined on the field in the data modeler will be used when
arecord is created. (Tri-74297-1J34257)

Record Runtime In the Form Builder, if you clear the title bar checkbox for a section, only the title
bar of the section hides in the form. The section is always visible irrespective of
any other section of the form is collapsed or expanded. (Tri-74356-1J34288)

Reporting For queries with a footer sum row that are run through the enhanced rendering
grid, the footer sum row will not display if the query results return no data.
(Tri-79659)

Reporting Number fields with the value zero are now sorting correctly, through manual sort

or with order by defined in the query design. The issue has been resolved for the
TRIRIGA query types: Query, Report, Summary and Hierarchy.

(Tri-76838-1335712)

Reporting For enhanced query rendering grids, the grid context menu that contains the Copy
option and sometimes the Export Excel option will now automatically hide when
the grid is out of focus. Also, the context menu will no longer display if the query
returns no results. (Tri-75186-1J34265)

Reporting An issue where context menus displayed on the enhanced query grids with zero
to only a few rows were being clipped and hidden has been resolved. The issue
was mainly occurring on form query sections. The context menu will now fully
display within the grid container and will be big enough to display a scroll bar so
all menu items can be accessed. (Tri-75748-1J35012)

Reporting Resolved an issue where chart reports were displaying an MID error at runtime
when the field representing the main group by column defined on the report no
longer exists on the business object. Any invalid group by fields will now be
ignored at runtime and a warning will display in server.log. Only the remaining
valid group by columns, if any will be used at runtime in this scenario.

(Tri-77325-1336479)

Reporting Resolved an issue where group totals were not showing the group row header in
reports with sum columns run with the enhanced rendering grids.
Note: If the results of the query have inconsistent currencies the group totals may
have unpredictable formatting results. (Tri-78153-1J37236)

Reporting Reports run through the enhanced query grids will no longer show the pagination
footer if no results are returned. (Tri-1J37483-78389)

Reporting Resolved an issue where the "No data to display" message overlapped the Sum
footer in the portal and form sections when records were filtered with invalid
data. (Tri-79660)

Reservations Organizer email addresses from iCal notifications now correctly match user
emails. (Tri-79282)
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Area of Change Description

Reservations Organizer email addresses from iCal notifications now correctly match user
emails. The reservations now display correct names for Requested By, Requested
For, and Organized By. (Tri-75882-1J35170)

Reservations The Availability tooltip will now properly display on Room Reservation when the
tooltip contains a comma. (Tri-77527-1J37103).

Reservations While exporting reservations from My Calendar, the exported list now contains the
Date and the Time for the reservation. (Tri-74226-1333390)

Reservations When using the Microsoft Graph API, reservations created through foundation
TRIRIGA now show the correct Start date and time and End date and time in the
Room Calendar in Outlook. (Tri-80875)

Security A user with a Self-Service license will now have Read access to the triCostCode
module. (Tri-76480-1J36204)

Security Several potential Cross-Site Scripting attacks have been fixed.
(Tri-69644; Tri-68618)

Security Log4j-boot.jar is removed from TRIRIGA Installation package. (Tri-78842)

Workflow Resolved an issue where UX draft mode message helper records were not getting
deleted. (Tri-79849)

TRIRIGA Application In TAS, jdbcCollection="NULLIDR1" has been added to the server.xml
Suite properties.db2.jcc property in DB2/DB2WH environments for performance
optimization. (Tri-80333)

TRIRIGA Application In TAS, for large environments where multiple UI pods exist, the UI pods are
Suite never scheduled to run on the same OpenShift Node for better availability in case
one of the Nodes goes down. (Tri-78793)

TRIRIGA Application In TAS, to accommodate long running processes, TAS Operator is no longer

Suite defaulting to 5 min or managing timeout values on all OpenShift Routes. New IBM
TRIRIGA Routes will not have the timeout added, while existing IBM TRIRIGA
Routes might be modified to remove the timeout value or adjust it according to
your needs. (Tri-79188)
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IBM TRIRIGA Application Platform 4.1 Properties Files

The following change to the TRIRIGAWEB.properties file is in this release. For more information, go to IBM
TRIRIGA Application Platform 4.1 documentation and select Installing IBM TRIRIGA Application
Platform>Configuring the platform>Properties files.

Area of Change Description

In TAS, the administrator will get a warning message regarding the end of
subscription when the entitlement file is within X days of expiration. This
value X can be configured through the SLS_EXPIRY_NUM_DAYS_WARNING
property in the TRIRIGAWEB.properties file (For example, 7). (Tri-74683)

Administrator Console

Reservations

Security

EXCHANGE_GRAPH_EVENT_CONSOLIDATION_INTERVAL=

Default is empty; this enables event consolidation for Microsoft Graph events.
When the field is set to a non-zero value, the dispatcher waits at least that
number of seconds before firing the event workflow. Any events for the same
resource that arrives during that period are discarded so the workflow is only
fired once. This is meant for internal TRIRIGA use and is experimental. Itis
not recommended to be used in a production environment unless fully tested.
It might be removed in a future release.

A new property BIRT_USE_SSL=TRUE|FALSE was added to indicate if a
secure socket should be used. The default values is FALSE.
If BIRT_USE_SSL=TRUE, then the following properties must also be defined:

BIRT_SSL_KEYSTORE= #absolute path to the keystore

For example,
/opt/ibm/wlp/usr/servers/defaultServer/resources/security/tririga-tls.p12.
BIRT_SSL_KEYSTORE_PASS= #string representing password for the keystore

For example, keystore-pass.
(Tri-78791)
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IBM TRIRIGA CAD Integrator/Publisher 13.1

This release includes important information, known limitations, and changes to IBM TRIRIGA CAD

Integrator/Publisher.

Important Information

No additional important information concerning IBM TRIRIGA CAD Integrator/Publisher is added for this
release. For important information related to previous releases, see the Release Notes page on IBM Support.

Known Limitations

No new known limitation concerning IBM TRIRIGA CAD Integrator/Publisher is found in this release. For
known limitations related to previous releases, see the Release Notes page on IBM Support.

IBM TRIRIGA CAD Integrator/Publisher 13.1 Changes

The following changes concerning IBM TRIRIGA CAD Integrator/Publisher is added for this release.

Area of Change Description

CAD Integrator

CAD Integrator

CAD Integrator

CAD Integrator

CAD Integrator

CAD Integrator

The issue with XRef Layers display is fixed with CI 13.1.0.0.
(Tri-72811-1332772)

CAD Integrator has been updated to use Log4j2. (Tri-79221)

Publishing a drawing with reference files is driven by the CAD Integrator plugin
menu. Whether using the CAD Integrator tool for AutoCAD or MicroStation, turning
on reference files is driven by the menu option. Open the Preferences menu, then
go to Drawing and there is a checkbox that drives this feature. Also, ensure that
the path that points to the folder where the reference file is locate has been
cleared. It is good practice to delete the temporary files located in that folder.
(Tri-71971-1334210)

After Uploading drawing to TRIRIGA, users with name ‘'alerte' or ‘alert' are now
able to export floor plans from building. (Tri-71841-33226)

In CAD Integrator's graphic section, some layers might appear unchecked. The
feature that drives this behavior is the Layer Filters menu. There might be
unpredicted behavior when there are multiple layers added that turn off the same
layers. These duplicate layer filters need to be updated or removed. Having
multiple filters that turn on or off certain layers can produce different results. (Tri-
72710-1334207)

CAD Integrator fully supports integration with AutoCAD 2022 and AutoCAD
Architecture 2022. (Tri-79767-1J38291)
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Area of Change Description

CAD Integrator In CAD Integrator, a user may choose to remove floor finishes from a particular
record. This can be achieved by creating a report query that reads from the space
and floor business objects. A custom query is required to achieve this process and
the removal of floor finishes. (Tri-71817-1334209)

CAD Integrator A security vulnerability is now fixed in CAD Integrator. (Tri-77276-1J35834)
CAD Integrator Resolved an issue supporting SSO login in AutoCAD. (Tri-72408-34202)
CAD Integrator A missing menu option is restored in CAD Integrator for AutoCAD. The Report

Preferences, also known as Drawing Properties, is now active and ready for use.
(Tri-76055-1334969)

CAD Integrator The triSpacelayer is enabled by default. It is fixed with CAD Integrator 13.1.0.
(Tri-69240-1J28819)

IBM TRIRIGA CAD Integrator/Publisher 13.1
Properties Files

The ci.properties file did not change in this release.
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IBM TRIRIGA Connector for BIM 4.1

This release includes a change to IBM TRIRIGA Connector for BIM.

Note that only one version of the TRIRIGA Connector for BIM can be installed on one workstation, even if you
are using more than one version of Revit. The BIM Connector installer can perform a new install, or it will
override any previous version of the BIM Connector that had previously been installed. When the BIM
Connector installer runs, it detects the versions of Revit that are installed on the workstation. If you have ever
installed BIM Connector as an add-in to that version of Revit, it will be overridden by the new install.

Important Information

No new important information concerning IBM TRIRIGA Connector for BIM is found in this release. For
important information related to previous releases, see the Release Notes page on IBM Support.

Known Limitations

No new known limitations concerning IBM TRIRIGA Connector for BIM are found in this release. For known
limitations related to previous releases, see the Release Notes page on IBM Support.

IBM TRIRIGA Connector for BIM 4.1 Changes

The following change to IBM TRIRIGA Connector for BIM is in this release:

Area of Impact Description

Connector for BIM Rooms tab in 'Space Use Class' now works correctly. (Tri-78704)
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Related Documentation

You will find the documentation for this release in IBM Documentation. Documentation for the IBM TRIRIGA
Application Suite is at https://www.ibm.com/docs/en/tas. The IBM TRIRIGA documentation is located at
https://www.ibm.com/docs/en/tririga and IBM TRIRIGA Application Platform documentation is located at
https://www.ibm.com/docs/en/tap. The documentation is available online in topics or as downloadable PDF
files.

Additional documentation, previously available in the IBM TRIRIGA wiki, is available in the IBM TRIRIGA
Application Platform 3.8 Knowledge Center under “Additional documentation” in the table of contents. For
more information, see the IBM TRIRIGA Release Information page on IBM Support.

Support

IBM Support provides assistance with product defects, answering FAQs, and performing rediscovery. View the
IBM Support site at www.ibm.com/support.
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Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in other countries. Consult
your local IBM representative for information on the products and services currently available in your area.
Any reference to an IBM product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product, program, or service that does
not infringe any IBM intellectual property right may be used instead. However, it is the user's responsibility to
evaluate and verify the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this document.
The furnishing of this document does not grant you any license to these patents. You can send license
inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation

North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte character set (DBCS) information, contact the IBM Intellectual
Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing

Legal and Intellectual Property Law

IBM Japan, Ltd.

19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other country where such provisions are
inconsistent with local law:

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS" WITHOUT
WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.
Some states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this
statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically made
to the information herein; these changes will be incorporated in new editions of the publication. IBM may
make improvements and/or changes in the product(s) and/or the program(s) described in this publication at
any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in any
manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of the
materials for this IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate without
incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the exchange
of information between independently created programs and other programs (including this one) and (ii) the
mutual use of the information which has been exchanged, should contact:
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IBM Corporation
27Z4A/101

11400 Burnet Road
Austin, TX 78758
U.S.A.

Such information may be available, subject to appropriate terms and conditions, including in some cases,
payment of a fee.

The licensed program described in this document and all licensed material available for it are provided by IBM
under terms of the IBM Customer Agreement, IBM International Program License Agreement or any
equivalent agreement between us.

Information concerning non-IBM products was obtained from the suppliers of those products, their published
announcements or other publicly available sources. IBM has not tested those products and cannot confirm
the accuracy of performance, compatibility or any other claims related to non-IBM products. Questions on the
capabilities of non-IBM products should be addressed to the suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or withdrawal without notice,
and represent goals and objectives only.

This information contains examples of data and reports used in daily business operations. To illustrate them
as completely as possible, the examples include the names of individuals, companies, brands, and products.
All of these names are fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

Privacy Policy Considerations

IBM Software products, including software as service solutions, (“Software Offerings”) may use cookies or
other technologies to collect product usage information, to help improve the end user experience, to tailor
interactions with the end user or for other purposes. In many cases no personally identifiable information is
collected by the Software Offerings. Some of our Software Offerings can help enable you to collect personally
identifiable information. If this Software Offering uses cookies to collect personally identifiable information,
specific information about this offering’s use of cookies is set forth below.

This Software Offering does not use cookies or other technologies to collect personally identifiable
information.

If the configurations deployed for this Software Offering provide you as customer the ability to collect
personally identifiable information from end users via cookies and other technologies, you should seek your
own legal advice about any laws applicable to such data collection, including any requirements for notice and
consent.

For more information about the use of various technologies, including cookies, for these purposes, see IBM’s
Privacy Policy at www.ibm.com/privacy and IBM's Online Privacy Statement at
http://www.ibm.com/privacy/details/us/en in the section entitled “Cookies, Web Beacons and Other
Technologies.”

Trademarks

IBM, the IBM logo, ibm.com, and TRIRIGA are trademarks or registered trademarks of International Business
Machines Corp., registered in many jurisdictions worldwide.

Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered trademarks or trademarks of
Adobe Systems Incorporated in the United States, and/or other countries.
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Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation in the
United States, other countries, or both.

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Oracle and/or its
affiliates.

Other product and service names might be trademarks of IBM or other companies. A current list of IBM

trademarks is available on the Web at “Copyright and trademark information” at
www.ibm.com/legal/copytrade.shtml
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